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PREFACE 

DEAR PROFESSIONAL, 

Welcome to the world of Computer Aided Building Estimation and Costing. Most 

important role of Quantity Surveyors is to estimate the cost of the proposed building; 

enabling the contractor to evaluate and determine the feasibility of the project. Hence 

accuracy of forecasting the cost of future projects is vital to the success of the business or 

organization involving in future construction projects. 

A Professional Quantity Surveyor has a comprehensive knowledge of construction, 

construction methods, local laws relating to construction projects and accounting, in 

order to provide cost and financial advice. 

The foundation for a successful cost estimate relies upon reliable identification of the 

quantities (takeoff) of the various materials involved in the project. Cost estimators 

develop the cost information based on the design developed by the design team members 

which will help the team to make budgetary and feasibility determinations. 

Course on Computer Aided Building Estimation and Costing lets you use the Autodesk 

Quantity Takeoff software in a more systematic way and improve your productivity 

accuracy. We truly believe this course would be beneficial to every professional planning 

to build a career as a professional Quantity Surveyor as well as, making an experienced 

Quantity Surveyor learn the software tools that could compliment their profession. 

The systematically organized courseware explains the method to perform a takeoff of 

a building based on non-intelligent image formats such as JPG, TIF and PDF and also 

from Building Information Models (BIM). It also covers the interactive examination of 

3D models, dynamic counting and quantifying the design data and the way of creating 

summaries and detailed quantity surveying reports. 

We wish you the most and more and assuring of World Class Learning Experience with us! 

S. Karaiadiselvan, 

Managing Director, 

CADD Centre Training Services Pvt. Ltd. 
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liNTRODUCTION 

!I! Estimation 

For all engineering works it is recommended to know the probable cost of construction i.e. Estimated 

Cost. If estimated cost is more than the available, then some modifications in design will made to reduce 

the cost. In preparing an estimate, the quantities of different items of work are calculated. One who able 

to read a drawing and understand the dimensions from the same, may calculate the quantities. Then 

these quantities are used to calculatethe cost. 

Methods 
Estimate: The estimate is the probable cost of a work and is determined theoretically by mathematical 

calculations based on the plans and drawing and current rates. Approximate estimate may be prepared 

by various methods but accurate estimate is prepared by Detailed Estimate Method. 

Actual Cost: The actual cost of a work is known at the completion of the work. Account of all expenditure 

is maintained on daily basis which will sum of at the end to get the Actual Cost. 

Detailed Estimate: Preparation of detailed estimate consists of working out the quantities of different 

items of work and then working out the cost. 

!E Autodesk Quantity Takeoff 

The process of mea.suring quantities of materials from drawings and specifications prepared by architects, 

engineers, and other designers is)<nown as quantity takeoff. Traditionally, construction cost estimators 

have used paper-based methods !O perform quantity takeoff. Autodesk Quantity Takeoff (QTO) gives 

estimators the tools to perform digital quantity takeoff, which is faster, easier, and more accurate than 

paper-based methods. 

Using QTO, you can combine multiple sources of two-dimensional and three-dimensional design data 

and generate quantity takeoff to create a cost estimate. You can bring information from applications 

such as AutoCAD, Autodesk Revit Architecture, and AutoCAD Civil 3D software, as well as 'non­

intelligent' CAD data and image formats . Both DWF and non-DWF files can be used as source files. 

All data associated with a given estimate is stored in a QTO project. 
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D DWF 

DWF stands for Design Web Format, which is an open, secure file format developed by Autodesk. Using DWF, you 

can combine rich 2D and 3D design data, as well as other project-related files , into a single, highly compressed file. 

Each DWF file contains one or more pages called sheets. Usually, the content of each sheet can be viewed, marked 

up, measured, and printed. However, in some cases, this is limited by the person who originally created, or published, 

the DWF file. 

In QTO, the source of the 2D or 3D DWF file determines the level of automatic quantity takeoff functionality that 

is available. You can use DWF files (and DWFx files) that are published from s~veral design applications. Because of 

variations in publishing methods, the source application of the DWF file determines the level of automatic takeoff 

functionality that will be available when you import the file into QTO. 

Publisher .:.,., , .. :\_ ,~fAutomatici'ai<eoff~~~;;~:. ~ _ 
Auto CAD No 

AutoCAD Architecture Yes 

AutoCAD MEP Yes 

AutoCAD Civil 3D Yes 

Autodesk Inventor No 

Revit Yes 

Much like Adobe PDF files, the contents of a DWF file cannot be altered. Unlike PDF files, however, DWF files retain 

design information (scale, measurements, assemblies), which makes them more suitable for architects, engineers, and 

designers. Also, DWF files are typically much smaller than PDF files. 

i& Non- DWF 

Non- DWF files that can be used in QTO include PDF files, DWG files, and image files, such as JPG, TIF, and GIF. 

Optimize PDF files for use in QTO by using the image settings within the PDF print driver to down sample all images 

to below 150 ppi. The default setting of 300 ppi is optimized for printer output, not on-screen display, so it will not 

deliver optimal performance for importing and displaying PDF images in QTO. 

QTO provides a comprehensive set of takeoff tools for use with 3D DWF models, 2D DWF sheets, and non-DWF 

files. Tool availability is determined by the types of files you use. If you work with model-based 2D and 3D DWF files, 

you can use either automatic takeoff tools or manual takeoff tools. If you work with DWG and image files, such as 

PDF's and TIF's, only manual tools are available. 

• Automatic takeoff tools: For use with 3D DWF models and 2D DWF sheets. Using the design data embedded 

in the DWF files by publishing applications, these tools create takeoff data automatically. 

• Manual takeoff tools: For use with 2D DWF sheets and non-DWF files (DWGs, PDFs, TIFs, GIFs, and JPGs). 

These tools create takeoff data by measuring drawing geometry that you select or manually trace on a sheet. 

Note: To have the DWG format as an import option , you must have DWG TrueViewTM installed. 

The following table shows the types of files you can use in QTO and the level of takeoff functionality available for each 

file type. 

2 
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£>ocument Type Automatic Takeoff · 1 Manual Takeoff 

ID DWF models Yes (all automatic tools) No 

DWF sheets Yes (Search Takeoff and Single-Click Auto Takeoff) Yes 

:JWG sheets No Yes 

PDF files (without password protection) No Yes 

;.:nage files (TIF, GIF, JPG) No Yes 

B] Project 

QTO, a project is a collection of files and takeoff items that yield the material quantities needed for a construction 

renovation job. Project files can include DWF files (2D sheets and 3D models), DWG files, and image files (TIFs, 

@Fs, and JPGs). 

e typical workflow in QTO involves these steps: 

• Create a project. 

• Import and organize documents (DWF and non-DWF files). 

• Set up the structure that will hold the takeoff data you create. 

• Specify sheet scale and units (for non-DWF files). 

• Create takeoff data. 

• Validate takeoff-data. 

• Output takeoff data to reports, export files, or DWF files . 

, Graphical User Interface 

-default, the toolbar is docked at the top of the QTO window, the Workbook is docked at the bottom, and frequently 

d palettes display as tabs at the left of the window (Figure ). 

- ~ Yiew I.,k~ff Qocument Beport Window ti,elp jS<¥<!> 

~ ~ 0.. • ·I ~ $0 I ~ . ~ • ® c, ·I ,. A ,a .g, (1) 

,_ II 

.. .=,. I SheetA101· Entryt.evel Upper Levell 

• f. 

< ITuesd.y: April l6, 2013 

Fig 1: Autodesk Quantity Takeoff 
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Menu Bar 
~-~ . ~ 

The menu bar at the top of the QTO window gives you access to all 

available actions. Clicking a menu bar item displays a set of related 

commands (f =;-t ·e 2). 

Qocument Report lt{ondow ]:!l!lp 

~ · ® 
"' Auto Pan Ctri+Shift+P 

Toolbar 
Modi!! 

,Search 

Selection Directly below the menu bar, the toolbar provides all the tools you 

need to navigate sheets and models, create takeoff data, and add 

markup. Using the takeoff tools, you can measure lengths and area, 

as well as count objects in project drawings (Figure 3). 

Fig 2: Menu Bar 

When you select a tool, tool options are displayed below the tool on the Contextual Tools palette. The Contextual · 

Tools palette identifies the currently selected tool and provides access to tool options, such as line or fill color, opacity, 

hatch pattern, text color, and font size (Figure 4). 

. . , ~< ~ ~ :-::r·- ~ ~ls T-s-:® r:d .,. A t0 &® 

lW ~ ~ T • TJ ~ F> J ~ T S T@ ~ TJ .,. A tD & ® ! -cn. ... T....,ff - - I [2J r I [Ek I C.Jor. ..... ~pad;,.,j"'~' . H 
- -- ~'--~ ..... -- - ---~ -- ---· . .. .. -- ---- · - •. , __ _ ----- · - ---~------- . 

Fig 3: Toolbar Fig 4: Tool bar with Contextual Tool Palette 

Canvas 
The canvas is the large area in the middle of the QTO window, which displays the sheet or 3D model selected on the 

Documents palette. On the canvas, you create takeoff from sheets and models, annotate sheets using markup tools, 

and validate the completed takeoff data . 

When displaying a 3D model, the canvas contains an additional screen element, ViewCube. Click the ViewCube to 

switch between standard and isometric views of your model. Use the compass ring on the ViewCube to orbit the 

model in any direction. 

Palettes 
The menu bar at the top of the QTO window gives you access to all available actions. 

Clicking a Project documents, takeoff data, and the tools you use to organize and view 

documents and data are arranged on palettes that display as tabs on the left side of the 

QTO window by default. Put the cursor on a tab to display the palette. If a palette is not 

shown in the QTO window, you can access it on the Window menu (Figure 5). 

Documents Palette 
The Documents palette is where you store and organize all sheets, models, and images for 

your project. The document you select on the Documents palette displays on the canvas. 

Project documents are organized in a folder structure that is similar to the navigation tree in 

Windows Explorer. You can add, rename, and delete folders to organize project documents. 

Takeoff indicators display on document icons to identify sheets and models that contain 

takeoff data. The amount of takeoff contained in each document is displayed in the Takeoff 

column on the Documents palette. The values in the Takeoff column represent the sum of 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

~ 

!:!elp 

Qocuments 

!ools 

bOntextual Tools 

Takeoff 

~orkbook 

Navigator 

,l!roperties 

,!!ookmarks 

Lal£ers 

Model 

~earch 

Reset Window La out 

Fig 5: Window Menu 

manual takeoff and visible automatic takeoff for each sheet and model. Automatic takeoff that is present in multiple 

views is counted for each document in which it is visible. The check box in the Legend column controls the visibility 

of sheet legends. 
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- legend is a reference table on a drawing sheet that lists and defines the colors used for takeoff markup on the sheet. 

ou can add a legend to any 2D sheet in a QTO project. 

eo .If Palette 

16·Ajl(·13 11:56:00 AM 

16·Ajl(·13 11:56:00 AM 
16·Ajl(·l3 11:56:00 AM 

0 16·Ajl(·13 11:56:00 AM 
16·Ajl(·13 11:56:00 AM 

0 16-Apr·13 11:56:00 AM 

Fig 6: Document Pa lette 

Ac:in'nstrator 

2 ... PublisMd Milli ••• Administrotor 

2. .. N>lish<d Mili ... Adrt'liistrator 

' Takeoff palette is where you store and manage all takeoff data for a project. The data is organized in the following 

archy, which forms the organizational structure of your project: 

e folders and subfolders, groups store takeoff data. In a typical construction takeoff, the information is organized 

discipline, division, trade, or view type (such as plans, sections/elevations, and details). In QTO, this highest level 

'organization is represented by groups. You can create multiple levels of groups and subgroups. 

ups contain items, which are families of objects, such as interior walls and plumbing fixtures, to be measured 

counted. Items contain objects, which are individual instances of the takeoff items in the sheets and models in 

project. This hierarchy of groups, items, and objects is graphically represented in an expandable and collapsible 

· ·igation tree (Figure ?). 

left side of the Takeoff palette contains check boxes that you use to control whether takeoff graphics are shown 

-dden on the canvas and whether takeoff data can be edited. Use the Takeoff palette context (right -click) menu to 

another view option: The Views command locates and zooms in to a selected takeoff object. 

·gator Palette 

n you are viewing a 2D sheet on the canvas, the blue frame on the Navigator palette outlines the area of the sheet 

is currently in view. This can be helpful when you are working with a very large detailed sheet. The blue rectangle 

""- as a magnifying glass on the sheet. Drag it to reposition the view location on the canvas. At the bottom of the 

·,.ator palette is a zoom control toolbar. Use the controls to zoom in or out by small or large increments (Figure 8). 

"' Oesaiption 
Building Areas "1111111 __ _ 

New kern • Room 
New ~-2 Existing Cond~ions 

... New~_3 Shell 

F g ~ Takeoff Palette Fig 8: Navigator 
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Model Palette 

When you are viewing a 3D DWF file, the objects that are published from the design application display on the Model 

palette in a navigation tree. 

You can make a selection at any level of the tree, and then right-dick to access commands for filtering the display of 

the model on the canvas and for creating takeoff for the selected group, item, or object: 

• Hide: Hides the selected object(s) from view 

• Hide Others: Hides all objects from view except the selected object(s) 

• Show All: Restores the default view of the model, with all objects shown on the canvas 

• Transparent: Toggles the object display between transparent and opaque 

• Invert Selection: Selects all objects except the object(s) selected on the Model palette 

• Takeoff: Creates takeoff for a selected group, item, or object and places the results on the Takeoff palette 

• Takeoff to Item: Adds takeoff results for selected items or objects to a specified item on the Takeoff palette 

Bookmarks Palette 

The Bookmarks palette displays any bookmarks that were created in the drawing file by the design application from 

which the drawing file was published. Use bookmarks to navigate to published or user-specified locations in the sheet 

or model. 

Layers Palette 

Use the Layers palette to show or hide layers that were created in the design application from which the drawing file 

was published. 

Search Palette 

Use the keyword search feature on the Search palette to locate all occurrences of a word or phrase in sheets, models, 

takeoff groups, items, and objects. Use the navigational links in the search results to navigate to an item and view its 

takeoff data. 

Workbook 

The Workbook palette is located at the bottom of the QTO window by default. Like other palettes in QTO, you can 

move the Workbook so that it displays as a tab on the side of the QTO window. Use the Workbook to view detailed 

takeoff data for the active sheet or the entire project. 

The Workbook is organized by tabs that match the top-level groups (for example, disciplines, divisions, or trades) on 

the Takeoff palette. It contains one additional tab: the Summary tab, which is a compilation of all takeoff information 

for all categories. 

Note: The units of measure that display in the Workbook are typically specified when you create takeoff items; however, 

you can modify them directly in the Workbook. 

!lf&1 Cross-Selection of Objects 

When you select takeoff geometry on the canvas, the corresponding object is selected both on the Takeoff palette and 

in the Workbook. Similarly, when you select an object on the Takeoff palette or in the Workbook, the takeoff geometry 

is selected on the canvas. This 3-way visual cross-referencing of objects-on the canvas, at the project level (Takeoff 

palette), and at the sheet or project level (Workbook)-can help you manage and validate takeoff data. 

These are the rules that govern the visual cross-referencing of objects: 

• A selected object is always highlighted in blue on the Takeoff palette and in the detail view of the Workbook. 

6 



:-apter 1 

e :\tlodel 

lay of 

e 

ette 

n from 

sheet 

· g file 

odels, 

:lew its 

m u can 

tailed 

~ es) on 

ation 

e and 

oometry 

-:=-a.keoff 

ook. 

CADD" 
CENTRE ing Estimation and Costing 

W hen the item that contains a selected object is collapsed, the item is highlighted in gray, indicating that it 

contains the currently selected object. On the Takeoff palette, expand the item to see the selected object. In the 

summary view of the Workbook, double-click the item to see the selected object. 

• W hen the takeoff group that contains a selected object is collapsed, the group is not highlighted. Expand the 

group to see the highlighted item; expand the item to see the selected object. 

W hen an object is selected on the canvas, right-click, and click Locate Object to quickly find the corresponding 

item and object on the Takeoff palette. QTO expands groups and subgroups on the Takeoff palette, as needed, 

to expose and highlight the selected object. The object is also highlighted in the Workbook, but QTO does not 

expose it automatically as it does on the Takeoff palette. 

Cross- selection also works on DWF files published from QTO. 

• Modifying the Column Layout on Palettes 

can show/hide, resize, and sort columns on the Documents palette, on the Takeoff palette, and in the Workbook 

anage the display of data. You can move columns on the Documents palette and in the Workbook. The column 

· gs you specify persist from session to session. 

- e or show a column: 

• Right -click any column heading, and click the name of the column you want to hide or show. 

ge the width of a column: 

Put the cursor over the boundary on the right side of the column heading. The cursor changes to a double­

headed arrow when the boundary is selected. 

Drag the boundary until the column is the width you want. 

ize the width of a column: 

• Double-click a column boundary to change the column width to fit the contents. 

columns: 

' ' default, columns are sorted alphanumerically in ascending order. 

Click a column header to sort the values in the column alphanumerically in descending order. 

Click the column header again to sort it in ascending order. 

ge the column order: 

' the Documents palette and in the Workbook, move any column (except the Description column) by selecting it 

dragging it to a new position on the palette. 

ge the tab order in the Workbook: 

·e any tab by selecting it and dragging it to a new position in the Workbook. 

Adding add itional Currencies 

efault Autodesk Quantity Takeoff comes with the following currencies. 

lc. EUR 

I
¥.JPY 
RS. BRL 

$. USD 

£.GBP 
SFr .. CHF 
NZS. NZD 

IAUS.AUD 

Fig 9: Currencies 
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To add additional currencies, you need to modify the 'Currencies.xml' ii.le located at C:\Program Files\Autodesk\ 

Quantity Takeoff 2013. 

• Open the 'Currencies.xml' in a text editor (Figure 10). 

• Add one more currency as follows. 

<currency prefix="Rs:' suffix="Indian Rupees" unit="" language=nn»lndian Rupees</ currency» (Figure 11) 

lfc:?XIIl version="l.O" enco<Hng.s"utf-8"?> ""•7'-x'-'o1°v;;;,:;;,.c.-;on=··"l'.o""·-:,.:::,::::.,><;:::..,.:c•o::o<t=-r»""",--------------------
<Qto> <qto> 

cdefi ni ti ons> <defi ni ti ons> 
=~~~~~~~;;~~r~cy•"" unH•"" /> =~~~:~~~i~~:r~cy. ·" uni~- /> 

<currency prefix•''S'' suffix•"USO" unit•"Iqlerial" language•''ENU">US oollar</ currency> 
<Currency prefix•"€" suffix•"EUR" unit•"Metric" language .. "OEU">Euro</currency> 
<currency prefix•''€ .. suffix•"EUR" unit•'..,e:tric" language•"FRA">Euro</ currencp 
<currency prefix•"¥'' suffix•")PY" unit•"Metric" language•")PN">Japanese Yen</currency> 
<.currency prefixa"RS" suffix .. "BRL'' unit • "Metric" lanQuage="PTB">Brazilian Real</currency> 

~~~ ~ ~:~~ ~ ~:~1 ~=: ~ r ~~f:~ ~f~~~f.~~!! i ~n i ; .... ! !n?~~g~:~e~f.~~~ei ~;e; ~!~~;~~~~~~~~ 

<currency pre 
<currency pre 
<currency prefix•", 
<cur rency prefix., " 
<Currency prefix•"l 
<currency prefix•" 
<Currency prefi x•" 

suffi x--ustt" uni~-~al" l~a~•""E~<U >OS Ocill~r</currency> 
suffix--a.-- C..lt-~tric" 1U9/age."DEU">Euro</ currency> 
s uffix-"EtR" wsi -:..'""etri c" language•"FRA">EurO</currency> 
suffi x-"JPY"' unit>< "'Metric" l&ry9Uage•" JPN">Japanese Yen</currency> 

" suffi x-"SRt. • unit • .,.etric" l an~age•"PTB">Brazilian Real</currenc)'> 

r ~~~~~~~~i~i ~-)~~~=~e~e2~~!; ~;e~~!~~~~5~~~~~~ 
<currency prefix .. "NZ S" suffix:oO'NZo" unit •"Metri c" language•'"'>New zealand ~llar</currencY> 
<CUt:"rency prefixz"AUS" suffix="AUD" unit ="Metric" language•"">Australian Oollar</ currency> 

</currencles> 
</definitions> 

</qto> 

<cu rrency pref 
<currency pref 

</currencies> 
</definitions> 

</ qto> 

,."NZS" suffix-~'" unit '""""Metri c" language:'"'>New zealand oollar</currency> 
•"AU S" suffixa"'.I.I.O" vni t •'"Metric" language•"">Australian oo11ar</currency> 

Fig 10: Currencies.xml Fig: 11: Modified Currencies.xml 

• Save and Close. 

Note: It's advisable to make a backup copy of the Currencies.xml file prior to making any modifications 

013 Preferences 

Use the Preferences dialog to control the display and behavior of the following application components: user data, 

dialogs and alerts, models, property mapping, item types and assignments, and automatic project file backups. Use 

the controls on the tabs in the Preferences dialog to select options for each component. 

To specify preferences: 

8 

1. Click Edit menu » Preferences. 

2. On the User Data tab, enter your name and company 

name (Figure 12). 

3. On the Model tab, specify the following view settings: 

a. Enable Hardware Acceleration: Select if you want 

to take advantage of any performance enhancement 

that is possible with your graphics processor. The 

new setting will take effect when you navigate back 

to the current sheet after navigating to a different one. 

User Data 1 , ... ~ 1 ··~~ 1 .. ~" '»""'"" 1 r..a"" ..x;JY'II;;' 1 ··~·gvw 1 ~"'"""" 1 11 

Company: 

OK j [ Cancel 

Fig 12: Preferences 

b. Enable Takeoff Model Color: Selected by default, this option enables the takeoff color-coding of 2D views 

in 3D views. Auto desk Quantity Takeoff must be restarted if you clear this option. 

4. On the Mapping tab: 

a. For Publisher, select either AutoCAD-based or Revit-based to identify the source of the design documents. 

b. For Language, select the language to use for the property names. 

c. If you want to modify any property names, double-click the current value, and enter a new name. 

5. On the Item Type tab, after you have run model takeoffs, you can review the item types you specified for design 

items when defining model takeoff data, and delete any item preferences that you do not want applied to future 

model takeoffs. To delete an item preference: 

a. Select the item preference, and click Delete. 

b. When prompted to confirm the deletion, click Yes. 

6. On the Auto Save tab, if you want your QTO project to be saved automatically, select Enable Auto Save, and 

specify the frequency for saves by selecting a number of minutes. Automatically saving your project can minimize 
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data loss if you experience a hardware or software crash while the project is open. When you enable auto saves, 

the timer starts as soon as you click OK. After the specified number of minutes has elapsed, the current project 

is saved to the backup copy of the project file, which is in the same folder as the original project file. 

On the Interface tab, select the check boxes next to the dialogs and alerts you want the application to display. 

For example, if you want the Quick Start dialog to display each time you launch QTO, select Quick Start. 

On the Assignment tab, if you have created assignments, you can review these relationships between model 

takeoff items and catalog items (shown in the Assigned To column), and delete any assignment preferences 

that you do not want applied to future model takeoff results. Items are listed in ascending alphabetical order, 

based on the label style you specify (either Item Only, Item and Parent Group, or Item and Root Group). To 

delete an assignment preference: 

a. Select the assignment preference, and click Delete. 

b. When prompted to confirm the deletion, click Yes. 

Creating a New Project 

TO project is a collection of drawing files and takeoff items that yield the material quantities needed for a construction 

renovation job. Drawing files can include both DWF and non-DWF files. Takeoff items are typically organized in 

talog, grouped by disciplines, divisions, trades, or other categories. 

• Start Autodesk Quantity Takeoff. 

• Select 'New Project' in the 'Quick Start' Dialog (or) File menu» New (Figure 13). 

• In the Project Setup Wizard dialog » Name Project page, assign the working directory and project name. Click 

Next (Figure 14). 

Fig 13: Quick Start Dialog Fig 14: Name Project 

• In the Project Settings, select the unit system and the currency. Select 'Set as default; if you want to save this 

settings as default for new projects (Figure ... s). 

• On the Select Catalog page, browse to C:\Program Files\Autodesk\Autodesk Quantity Takeoff 2012\Help\ 

Getting Started (Metric) \Getting Started_metric.att and Import. Click Next (Figure 16). 

Fig 15: Unit System and Currency Settings Fig 16: Catalog 

9 
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• In the Import Files dialog, Add the given ".dwf file. 

• Finish 

• The project is created, and a message notifies you that the project is ready to use. Click Close. 

• The project opens. Because you selected a catalog to import, QTO now gives you the opportunity to specify 

the exact catalog content to import (Figure 17). 

• Select the required content and click OK (Figure 18). 

R Project Settings 

The Project Settings dialog contains separate tabs where you can specify the security, units, takeoff, and time settings 

for a project, as well as view the currency system you specified for the project when you created it (Figure 19) 

Select llems To 

rtJ~ I~I=Dllllllim 
rit-0Existing Conditions 
tit@ shell 
~Interio rs 
~Materials 
lit-~ Mechanical 
~Spedalties 

I OK II Cancel I 

~fD=nnenls (3) 

!lU~J @) @ ® 

ru l~ 
q i!i Revit Architecture Model _ 

U 
I! fi\ Sheet A 103 - unnamed ! 

. . . 
8 Sheet: A 104 - unnamed 

6 Sheet A lOS -unnamed 

0 

0 

0 

-~IQI' 

0 
0 
0 

Project SettirigS 

--i§Jli!k 
Unils 
Currency 
Takeoff 
Time 

Fig 17: Catalog Content to Import Fig 18: Imported Documents 

Security 

~Pr.-ticn 

['] Password Protect this File 

PassWOfd: I I 

Re-Enter PasSWO<d: 1 [ 

~ 1 eance1 J 

Fig 19: Project Settings 

You can add or remove password protection for a project at any time. When you add password protection to a project, 

any user attempting to open the project must first enter the designated password. To add password protection to a 

project: 

1. Open the project. 

2. Click File menu » Settings. 

3. In the Project Settings dialog, click the Security tab. 

4. Select Password Protect this File. 

5. For Password, enter a password. 

6. For Re- Enter Password, enter the same password you entered above. 

7. Click OK. 

To remove password protection from a project: 

1. Open the project. 

2. Click File menu » Settings. 

3. In the Project Settings dialog, on the Security tab, clear Password Protect this File. 

4. Click OK. 

Units 

These rules govern changes to project units on the Units tab of the Project Settings dialog: 

10 

• Unit System: You cannot change the unit system (imperial or metric) that was specified when the project was 

created. 

• Quantity Units: These are the default measurement units that are used for new items and items with an Undefined 

item type. Changing the Quantity Units values has no effect on existing, defined takeoff items. Therefore, if you 

change the Quant ity Units values after takeoff data has been created, existing measurements for defined items 
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on the Takeoff palette and in the Workbook will not be converted to the new units. To change the measurement 

units for defined items, use the Takeoff Item Properties dialog. 

• Canvas Display Unit: You can change the display unit at any time, and the units that are displayed for existing 

o specify takeoff measurements on drawings will reflect the new unit (Figure 20). 

ency 

e rules govern changes to currency settings on the Currency tab of the Project Settings dialog: 

• Currency: You cannot change the currency system that was specified when the project was created. 

• Use Long Format: You can change the currency format (short or long) at any time. 
e settings 

_c.) 'eoff 

a project, 

on to a 

ject was 

-ndefined 

~ re, if you 

- ed items 

se the Takeoff tab of the Project Settings dialog to control the default linear thickness and label size for the current 

- off project. 

Click File menu » Settings. 

In the Project Settings dialog, click the Takeoff tab. 

Specify the default thickness for linear takeoff. To use the specified lineweight for all linear takeoff, select Always 

use default thickness. 

Under Label Defaults, specify the default settings for label font size and color. Also specify the contents of the 

label which can be a combination ofWBS information and quantities, or neither. 

e 

Click OK (Figure 21). 

Note: Whe n you change the takeoff defaults, any new takeoff that you create will reflect the new defau lt settings. Existing 

takeoff measurements on drawings are not updated to reflect new lineweight and label size settings. 

Project SOttings 

. s[macffiuritvii. 111111 I~.;DeEa.At=;;,;u.;;;;;.·~a;;;... ______ __.l 

Currency lkll Syaem 
Takeoff 
Time Sys~ Metric 

Quartiy lkU 

Length: 'lm-----.~ 1 He;ght ~ 

kea: jm1 •+ Thickne$s: ~ 
Volume: lm' ~ I 

Fig 20: Units 

Project Setting 

Security 
Units 
Currenc. 

Mtfitft';_ 
Time 

I Takeoff 

Unear Thid<ness 

Default Thickness 1/4pt 

0 Always use default thickness 

Label Defds 

Text Size: 

Text Color: 

Label Contents: 

4pt 

I WBS + Qunxy 2 

[ OK I I 
Fig 21: Takeoff 

. 
· I 

Cancel I 

m values entered on the Time tab of the Project Settings dialog are used to calculate time-based costs associated with 

. By default, time calculations are based on 8 work hours in a day, 40 in a week, and 160 in a month. However, you 

edit these values and, thereby, change the multipliers in cost calculations -ProjectSetti 

involve time. For example, if you specify a work day of 7 hours instead of 

our work week will be calculated as 35 hours, and your month as 140 hours. 

Click File menu » Settings. 

In the Project Settings dialog, click the Time tab. 

3. On the Time tab, specify the number of hours in a standard work day, 

week, and month for the current project. 

Click OK. 

Security 
Units 
C~:rrency 

Takeoff 
MiU,t. 

T" 
- -- ~ - -

I~Ttme I 
One Day equals: -8 - hours 

One Week equals: 5 days 

One Month equals: 4 weeks 

I OK I I Cancel I 

Fig 22: yme 
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Note: When you change t he ti me defau lts, items with ho urly costs in the curre 

costs display in t he Wo rkbook. 

.ject a re recalculated, and the updated 

f&E Organizing Your Project 

When you create a project, the documents you import are organized in folders on the Documents palette. After 

creating the project, you can import additional documents. You can also move, rename, and delete documents and 

folders at any time during the project life cycle, but it is generally best to organize project documents before you start 

the takeoff process. 

To add a top- level folder 

• On the Documents palette, click New Folder. You can also right-click an empty area of the palette, and click 

New Folder. 

• Enter a folder name, and press ENTER. 

To add a subfolder 

• On the Documents palette, select the folder where you want to create a subfolder, and click New Folder. You 

can also right- click the folder where you want to create a subfolder, and click New Folder. 

• Enter a folder name, and press ENTER. 

To move documents to a folder 

• On the Documents palette, expand the folders that contain the documents you want to move. 

• While pressing CTRL, select all the documents to move to a folder. 

• Drag and drop the selected documents into the folder. 

To rename a folder 

• On the Documents palette, select the folder to rename, right-click, and click Rename. You can also select the 

folder, and click in the Name column to enter editing mode. 

• Enter a name for the folder, and press ENTER. 

To delete a folder 

• On the Documents palette, select the folder to delete, and click Delete. You can also right-click the folder, and 

click Delete. 

• In the alert dialog, click Yes. 

To delete a document 

• On the Documents palette, select the document to delete, and click Delete. You can also right- click the document 

or folder, and click Delete. 

• In the alert dialog, click Yes. 
,,.!!!-

' 
In the previously created projectj 
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• In the Document palette, select the folder and 

right click. Select th~ 'Rename' tool to rename 

it as 'Plan Views: 

New folder 

Cut 

Copy 
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• Right Click on the Document palette and create two more new folders with the name of 'Elevation Views' and 

'Section Views' (F" gure 24). 

• Select and Drag the sheets to the respective folders (Figure 25). 

• Rename the sheets as follows (Figure 26). 

=· 
-to I T~off I Legend 

- Plan Views 

~~~::~ii~~F~~~~~:-:.:l 
fi Sheet: A 105 • Unnamed 

- Section Views 

Fig 24: New Fo lders 

0 

0 

0 

Creating a Catalog 

0 
0 
0 

Documents (3) 

©)@@) ~ 

"' r Takeoff I Le~end 
Elevation Views 

~f0..~~-~'-~F~.~~.::::~~~r!~ii.'.~~:J 
Plan Views 

~ Sheet: A 103 • Unnamed 

Section Vtews 

6 Sheet: A 105 ·Unnamed 

o o 
o o 
o o 

Fig 25: Organizing the Folders 

Documents (3) 
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Elevation Views 
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.. Plan Views 

fii Pian 
.. Section Views 

fif.S..~.~~~] 

5 

--~- ] Takeoff ! Legend ! 

0 0 
0 0 
0 0 

Sheet Rename 

you created your project, you based it on the Getting Started catalog, which populated the Takeoff palette with 

ff groups and items. You can add, delete, and rename groups and items to customize the Takeoff palette for your 

n•· ·ect . After you customize the Takeoff palette, you export it as a catalog, which can be used in other projects. In 

.:ttlf reviously created project; 

unneeded takeoff groups: 

On the Takeoff palette, click the 'Unlock all' icon in the column header next to Description, and click 'Yes' when 

prompted to confirm the unlocking. This unlocks the catalog, allowing you to make changes. You can also lock/ 

unlock takeoff groups and items individually. 

Takeoff 

+ Description 

Building Areas 

&isling Conditi ... 

SheD 

Interiors 

Materials 

Mechanical 

t\ The group(s) and/or item(s) you are unlocking contain 
._j_} data imported from a catalog. 

Do you wish to continue and unlock these item(s)? 

0 Do not show this dialog again. 
,.--Yes-......,11 No 

Unlock Catalog Items 

Select and Delete the following Catalog Items. 

Specialties 

Mechanical 

Existing Conditions 

Takeoff 

~@ " [i"ew AII 

100 WBS + Description 

0 D .. New Group 

0 D .. New Group_3 

0 D .. New Group_ 4 

0 D .. New Group_5 

Building Areas 

Shell 

Interiors 

Materials 

Catalog Items 
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Note: As you saw in an earlier exercise when importing a catalog, you can 

exclude groups from your project catalog by clearing check boxes in the 

Select Items to Import dialog. Takeoff groups, whether created through t he 

catalog import process or with tools on the Takeoff palette, can be de leted at 

any time. If you attempt to delete a group or item that contains takeoff data, 

QTO alerts you that your selection contains takeoff data and prompts you to 

confirm the deletion. 

T alr.eoff Group 
. . -- . 

· ~J· ... - X ~ ~ - --· -

WBS: Exterior 

Oescripijon: Exterior constructionl 

Gelle<l!l [ 

c 
Rename a takeoff group: c::::.QK:J [ Cancel J 

• To rename a group, right click on that and select properties. For 

this practice, click on 'Shell: 

• Enter the following. 

• WBS = Exterior 

• Description =Exterior Construction (Figure 29) 

Add takeoff groups: 

Fig 29: Group Rename 

• On the Takeoff palette, click an empty area of the palette and click New Group (Figure 30). 

• Assign a Name and press Enter (Figure 31). 

• Select the created Group and click New Group (Figure 32). 

• Assign a name for the created sub-group (Figure 33 ). 

ldiU:Vn 

Cut ! Takeoff Takeoff 

I , ~@@ IViewAII a@) 
Copy . ~@0 jViewAII d G'J ~@0 jViewAII d B 

· · - · . . - - ~ 0 was + Oes<ription 

Paste ~ 0 WBS + 1 Desc:ription [;;;ew Group ~ "' I Desc:ription ~ 0 • E>derior E>deriorconstruc 

Delete 1~0• E>derior fe.teriorconstruction 'I ~QI•I:)Cierior [Exteriorconstruction ~0• , , 
I ~0 . . . •· . ~0 . . .. •· . ~0 Fumit- Fumit-

1 
~ 0 • New Group ~Building hells ~ 0 • New Group rl!uilding .Areas ~ 0 • New Group Building Pleas 

, ~ O • New Group_ 4 Interiors · ~ 0 • New Group_ 4 Interiors ~ O • New Group_ 4 Interiors 

~~ ~0•NewGroup_5 Materials ~0•NewGroup_5 Materials ~O•NewG!oup_S Materials 
Duplicate 

Fig 30: New Group Fig 31: New Group Fig 32: New Group 

• Repeat the steps to create some other groups and sub-groups. 

Export a takeoff catalog: 

• Select File menu » Export Catalog (Figure 34). 

• In the Save as Catalog dialog, navigate to a location to save the created 

Catalog. 

• Enter a File name and click Save. 

The hierarchical structure of the groups and item data displayed on the Takeoff 

palette is saved in the catalog. Modifying a standard catalog and saving it with 

a new name is an efficient way of creating catalogs to meet the requirements of 

your project or office standard. Use catalogs to ensure a consistent data structure 

across QTO projects within your organization. 

Import a Catalog: 

You can import takeoff groups and item names into the Takeoff palette from a 

catalog or a spreadsheet. If any imported group or item name is the same as a 

name that is already on the Takeoff palette, a numerical suffix is added to the 

name of the imported group or item to prevent duplicate names. 
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Click File menu » Import » Catalog. 

In the Import Catalog dialog, navigate to the ATT, CSV, or TXT file, and click Import. If you have installed a 

supported estimating application, you may also see a file extension that is specific to that application. 

In the Select Items to Import dialog: 

a . Expand groups to see any items they contain. Clear the check boxes for groups and items you want to exclude 

from your project. 

b. To save your selections as catalog preferences that can be used when you import the same catalog in the 

future, select Save selection with catalog (*.att option) . If you do not save your selections with the catalog, 

during future imports, all categories will be selected by default; however, you can still choose to include or 

exclude them as needed. 

c. Click OK. 

n import, the selected groups become top-level groups on the Takeoff palette, and they contain the items you 

ed. If the Takeoff palette was empty before you imported this catalog, all groups are locked by default. Otherwise, 

: the newly imported groups are locked. 

the Takeoff palette, unlock the groups or items that you want to modify. If all groups are locked, you can unlock 

groups and their associated items by selecting Unlock All next to the Description column header and clicking Yes 

• confirm the unlock operation. 

o import spreadsheet data: 

1. Verify that the data is in a comma-separated format and saved as a CSV file. 

2. Click File menu » Import » Catalog. 

3. In the Import Catalog dialog, navigate to the CSV file, and click Import. 

• Creating and Organizing Work Breakdown Structure Takeoff Groups 

Customize the Takeoff palette to suit your project requirements or office standard by adding, moving, merging, 

enaming, and deleting Work Breakdown Structure (WBS) groups for your takeoff items. WBS groups are shown on 

me Takeoff palette and in the workbook as an alphabetized organizational column. The information is also listed on 

me Properties palette when an item is selected. Create subgroups within WBS groups to refine the organizational 

structure you need. 

Note: After you have customized the Takeoff palette, you can export it as a catalog for use in other projects . 

To create a top-level WBS group 

1. On the Takeoff palette, click an empty area of the palette so that nothing is selected, and click New Group. You 

can also click palette menu » New Group, or right-dick and click New Group. 

2. Enter a name for the WBS group, and press ENTER. The WBS group is created at the root of the Takeoff palette 

and displays in the far left column. 

To create a subgroup with the New Group command 

1. On the Takeoff palette, select the WBS takeoff group or subgroup for which you want to create a subgroup, and 

click New Group. You can also click palette menu » New Group, or right-dick and click New Group. 

2. Enter a name for the subgroup, and press ENTER. The subgroup displays below the group. It is indented 

show that it is contained within the higher-level group. 
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To create a subgroup by moving one group into another 

1. On the Takeoff palette, select the group you want to become a subgroup. 

2. Drag and drop the selected group on top of the group you want to contain it. The subgroup is contained within 

the group. Expand the higher-level group to see the subgroup. 

To dup li cate groups or subgroups 

On the Takeoff palette, right-click the group or item you want to duplicate. 

ect one of the following. 

- o duplicate a group, its items, and its objects, select Duplicate. 

o duplicate just the group and its items, select Duplicate Without Objects. 

To merge groups or subgroups 

1. On the Takeorr palette, select the takeoff groups or subgroups to merge. You can merge a set of groups or a set 

of subgroups, but you cannot merge a mixed set of groups and subgroups. 

2. To select a set of consecutive groups, press and hold SHIFT while selecting the groups. To select a set of non­

consecutive groups, press and hold CTRL while selecting the groups. 

3. Right-click, and click Merge. You can also click palette menu » Merge. The selected groups are merged into a 

single group, which is selected on the Takeoff palette. 

Note: All selected groups are merged into the last group you select. 

To rename groups or subgroups 

1. On the Takeoff palette, select the takeoff group or subgroup to rename. 

2. Select one of the following methods. 

a. Click in the Description column of the selected group or subgroup to enter editing mode. 

b. Double-click the group or subgroup to open the Takeoff Group Properties dialog, where you can enter a 

new name as well as remarks. 

c. Right-click the group or subgroup and select a new label from Relabel Descriptions. You can choose Same 

Label for All, Label + Numbers, or Numbers only. 

To delete a group 

1. Determine whether the group contains takeoff data that you want to retain. 

2. On the Takeoff palette, select the group to delete, and click Delete. You can also right-click the group, and 

click Delete. 

3. To delete multiple takeoff groups, press and hold CTRL, select the groups, and click Delete. 

Note: If you delete a group that contains takeoff data, the data is deleted from the project. 

!E Takeoff Items 

QTO uses a takeoff item to represent a specific material or unit summarized in a materials list or catalog. Takeoff 

items can be simple, such as a door, or more complex, such as a wall assembly, which is made up of several component 

items. The manner in which takeoff is calculated for each item is determined by the item type you specify when you 

create the item. The following item types are available: 

• Linear: A linear takeoff item yields a linear measurement. Examples of this item type include trim and beams. 

• Area: An area takeoff item yields an area calculation. Examples of this item type include flooring and carpet. 

16 
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Volume: A volume takeoff item yields a volume calculation. Examples of this item type include concrete slabs 

and rooms. Objects \\;th this item type can be created only by automatic takeoff tools. 

Count: A count takeoff item yields a total number. Examples of this item type include doors, windows, and 

furnishings. 

Undefined: This is the default type for a newly created takeoff item. Undefined items are not counted or measured 

when you use takeoff tools. Change the item type to create a valid takeoff item that can be counted or measured. 

""". create a takeoff item 

On the Takeoff palette, select the group or subgroup in which 

to create the item, and click New item. You can also click 

palette menu » New Item, or right- click and click New Item. 

Enter a descriptive name for the item, and press ENTER. The 

new item is added to the selected group or subgroup. 

For Type, select the calculation to use for the item . 

Double- click the new item to open the Takeoff Item Properties 

dialog (Figure 35). 

On the General tab, define the following items. 

a. Under Dimension, enter values for all applicable 

dimensions, and select corresponding units of measure. 

The Dimension section of the General tab is populated 

with dimensions that are appropriate for the item type you 

Description: 

Type: 

Dimension 

Height: 

6 

Thickness: 

0 

Damp Proof Course 

ILnear · I 

Visual Display 

Unit Color: 

lm · I 
Unit: Opaci~t: 

lm ·I 70% 

Fig 35: Takeoff Items Properties 

selected when you created the item. If you change the item type, the dimension fields update dynamically. 

b. Under Visual Display, modify the default values as necessary. When you click the default color, the Color 

dialog opens, where you can select a different standard color or create a custom color for the display of the 

takeoff item. The Opacity percentage controls the depth of color 

applied to the color block that is displayed on the Takeoff palette I General I~ I Cost Data 

(and optional sheet legend) for the item. The higher the opacity 

percentage, the darker the color block. For items with an Area item 

type, you can assign hatch patterns (area fill motifs) and control 

hatch angle and scale. For Count items, you can specify the size 

and shape of count symbols that display on drawings when you 

create takeoff for the item. 

c. Under Remarks, add any additional information that is helpful in 

defining the item. Remarks can be included in custom reports, 

which you can export to several common file formats. 

On the Assembly tab, you can specify existing items that are 

component parts of the item you are defining. 

On the Cost Data tab, specify the per unit or lump sum costs (and 

optional time values) that will be used to calculate the Material Cost, 

Labor Cost, Subcontractor Cost, and Equipment Cost associated 

with the item (Figu ··c .16 ). 

a. Under Cost Quantities, Quantity 1 is the primary quantity for 

Cost Quantities 

Quanti~t 1 (0~/ 1): 

[Length 

Quantity 2 (Qty 2): 

!Prea 

lime 
Time: 

Cost Computation 

Material Cost: 

Unit: 

~] lm 

Unit 

· I lm• 

100.00 X IQty 2(Prea) 

Labor Cost: 

Subcontractor Cost: 

XL 
Equipment Cost 

Fig 36: Cost Data 

the item. The Quantity 1 value is fixed, based on the item type you selected. Quantity 2 is the secondary 

quantity, which you can use to produce quantities based on the dimensions specified on the General tab. If 

you enter a value for Quantity 2, select a corresponding unit of measure. 

,.,.., 
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b. For Time, enter the amount of t ime needed to construct the item. Trme can be computed on either a per 

unit or lump sum basis. To compute time on a per unit basis, enter a time value, and then select a QTO 

quantity as a multiplier: To compute time on a lump sum basis, enter a time value (such as 5 days) , and then 

select 1 as the multiplier. 

c. For Material Cost, enter the cost of raw materials for the item , either on a per unit or lump sum basis. 

d. For Labor Cost, enter the labor cost for installation, either on a per unit, lump sum, or hourly basis . 

e. For Subcontractor Cost, enter the cost of subcontracted labor, either on a per unit, lump sum, or hourly basis. 

f. For Equipment Cost, enter the cost of purchased or rented equipment needed for installation. As with the 

other costs, Equipment Cost may be entered either on a per unit, lump sum, or hourly. 

Calculation Type Cost I 
Per Unit 

Lump Sum 

Hourly 

Cost per unit of measure (for example, 

if the item cost is 12 per sq ft, enter 12) 

Qty 1 or Qty 2 (whichever unit of 

measure matches the cost you entered) 

Total cost of item 1 

Cost per hour (for installer or equipment) Hours 

!B Creating an Assembly 

Takeoff items that contain component items are called assemblies. For example, if an interior wall item is created as an 

assembly, you can expand the wall item in the Workbook and view the component items that make up the wall, such 

as gypsum wallboard, wood studs, and insulation. Before creating an assembly item, make sure all of the assembly 

components have been added to the Takeoff palette. 

HANDS-ON 

Create a takeoff item and an assembly on the Takeoff palette (Figure 37). 

• On the Takeoff palette, select Interiors » Floor Finishes, and click 'New item: 

• Rename the item as follows . And press Enter. 

• WBS =Floor 

• Description = Carpet 

• The carpet item is added to the Floor Finishes subgroup. For Type, select Area (Figure 38). 

Takeoff 
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a@] 
+ I Description 

Exterior construction 

Fumishing 

Building Areas 

Interiors 

Partitions 

New Item ~ Aoor. Ceramic Tile 

• New Group ... Ceiling Finishes 
New Group_5 Materials 

F1c: 3 New Item 

Aoor. ~mic Tile 
Area G 

undeflned 
Linear 
Area 
Volume 
Count 

Fig 3: ,, New Item Type 
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'Uble-click the new item. In the Takeoff Item Properties dialog, select a color shade, hatch pattern, angle 

scale (Figure 39). 

e Cost Data tab, enter the following. 

- [aterial Cost = 5.00; Multiplier = Qty 1 (Area) 

Labor Cost = 2.00; Multiplier = Qty 1 (Area) 

Equipment Cost= 20.00; Multiplier= 1 (Figure 40) 

alceoff Item 

WBS: Aoor 

Description: Carpet 

Type: I !Ilea · I 

General 

Oimension 

Thickness: Unit: 

0 lm · I 

Fig 39: Takeoff Item Properties 

Click OK. 

an item by copying a similar item: 

VIsual Oisplay 

Color: -Opacity: 

70~. 

Hatch: 

1- : 
Angle: 

0 

Scale: 

Material Cost 

Labor Cost: 

5.00 X , Clty,~) · I 

2.00 X ,Clty ,~) ·I 
Subcontractor Cost: 

Equipment Cost: 

20.0<1 X I 1 · I 

Fig 40: Cost 

On the Takeoff palette, expand Materials Woods, Plastics and Composites (Figure 41). 

Select 2440mm Wood Studs 50 x 100mm, right-dick, and click Duplicate. Copy of2440mm Wood Studs 50 x 

OOmm is added to the Takeoff palette (Figure 42). 

~~ ~~~ ~=Piastics&~sites 
~ New ~em 2440mm Wood Studs 50 ... 

~ "" New Group ... Thermal & Moisture Protection 
~ "" New Group... Finishes 

I~~ New~_5 MUrials ~ 'f New~ WOO<J$. f'IMiics & Conwstes 
~ New lem 2440:ml Wood~ SOx 100nm I~ New le... Copy cl 24Mmn Wood Studs SOx 100 ... 

~ • New~-·· Thermal & Moisttxe Protection 
~ • New~-·· linshes • 

linear 

Fig 41: Materials Fig 42: Duplicate 

:;)ouble-click Copy of2440mm Wood Studs 50 x lOOmm. In the Takeoff Item Properties dialog, enter the following. 

Description = 2440mm Wood Studs 50 x 150mm 

Type = Count 

Height = 2440; Unit = mm 

Thickness = 50, Unit = mm 

:\[aterial Cost= 4.00, Multiplier= Qty 1 (Count) 

:..abor Cost = 5.00, Multiplier = Qty 1 (Count) 
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Tabolfltem ·· ~~ 

WBS: New bem_2 

Deseriplion: 2441rnm Wood Studs 50 x 150mm 

Type: [eo.n 

Generol I Aoaombly I eo.t o.ta I 
[);memion 

Height; Unit 

2440 I""' 
~~----- Unit 

0 lm 
Thickness: Unit: 

50 I""' 

• Click OK. 

Create an interior wall assembly: 

·l 

· I 

· I 

· I 

VIS\JOI Olsploy 

Color: 

0p!lcily: 

3{)% 

Symbol: 
- 0--

Symbol Size: 

8 

Cost Computation 

Material Cost: 

Labor Cost: 

Fig 43: Takeoff Items Properties 

4.00 X I Qty 1 (Court) T I 

5.00 X I Qty 1 (Court) · I 

• On the Takeoff palette, under Interiors, select Partitions, and click New item (F' gure 44). 

Exterior 
Furnishing 

New Group 

NewGmup_4 

Exterior construction 

Furnishing 

Building Areas 

lnteriOIS 

• New Group Part~tons 

New kern Wall. Interior. 124mm PartHian (1-hr) 

New ke ... I ~ Wall. Interior, 108mm Cavity WaH 

New ke... II Wall. Interior. 155mm PartHian (2·hr) 

Interiors-Partitions 

Linear 

Linear 

Linear 

• NewGmup_4 

il • New Group 
New kern 
New le .. . 

Newke .. . 

• In the Takeoff Item Properties dialog, enter the following. 

• General tab: 

Height = 2440; Unit = mm 

Thickness = 150; Unit = mm 

Color = <select a color» 

• On the Assembly tab: 

lnteriOIS 
Partttions 

Wall. Interior. 124mm Partftion (1-hr} 

Wall. Interior. 108mm Cavity Wall 

... 
Fig 45: New Item 

Create a New Unit. In the Browse dialog, select the components by doing the following: 

Expand Materials, and expand the subgroups to display the component items. 

Chapter 1 

Linear 

Linear 

Linear 

While pressing CTRL, select the following: Gypsum Board, 16mm; Insulation Fiberglass, Blanket, R- 19; 

and 2440mm Wood Studs 50 x 150mm. 

20 

Click Select (FiP'L re 46). 

• In the Takeoff Item Properties dialog, click Apply (Fgure 47) . 

., ill New Group_5 • Materials 

., ill New Group· Woods. Plastics & Composites 

Nev; Item - 2440mm Wood Studs 50 x 100mm 

• Newltem_2- 2440mm Wood Studs 50 x 150mm 
., liill Ne.v Group_2- Thermal & Moisture Protection 

• New Item- Insulation Fiberglass. Blanket. R-19 

., Iiiii New Group_3 - Finishes 

• New Item- Gypsum Board. 16mm 

Assembly 
"' Assembly 



Chapter 1 

et, R-19; 

ding Estimation and Costing 
CADD" 
CENTRE 

• interior wall assembly is created. Next, you add formulas for the components, which will allow the software to 

ate item quantities and costs. The costs you specify for the components of an assembly supersede any costs you 

":' erify for the assembly item itself. 

For Gypsum Board, 16mm, click in the Quantity 1 column. In the Formula Editor: For Quantity Values, select 

Area. The value is displayed in the fx field, and the formula is displayed below it. All formulas begin with an 

equal sign ( = ). 

For Operators, select/. 

In the fx field, after Area/, enter 2.88. 

Finish (Figure 48). 

Note: For a standard 1220 x 2440 mm sheet of gypsum wallboard (2.88 square meters), the formula to determine the number 

of sheets needed for one side of a wall is Area/2.88. If you want to calculate the number of sheets needed for both s ides 

of a wall. you wou ld enter (Areaf2 .88) x 2. 

In the Takeoff Item Properties dialog, for Gypsum Board, 16mm, click in the Unit column, and select ea. This 

is the unit of measure that the software will use when calculating the count formula. 

Using the same method, specify formulas for the other components: 

• Insulation: For Formula, specify Area/.702, and for Unit, select ea. (This is the area of a standard 2340 x 

300mm batt of insulation, converted to square meters.) 

• 2440mm Wood Studs 50 x 150mm: For Formula, specify Length/.406, and for Unit, select ea. (This calculation 

allows for a stud every .406 m.) (Figure 49) 

FOmiilla Editor - New ~· _., ' 

------ -- -- - -----

Operators Functions 

~ [0 fx Area/2.8& 

Quantity 1 = Area/2.8& 

Fig 48: Formula F1g 49: Formulas 

Click OK. 

Quantity Takeoff 

provides a comprehensive set of takeoff tools for use with 3D DWF models, 2D DWF sheets, DWG sheets, PDFs, 

~ image files (TIFs, GIFs, and JPGs). The type of document you select on the Documents palette determines the 

that are available for automatic and manual takeoff (or) on-screen takeoff. 

Automatic Ta-keoff ~ Manual Takeoff 
~ ~ .... , ~- ·; ,-;i .,.:: "-

Yes No 

DWF sheet Yes (except Model Takeoff) Yes 

G sheet (from DWG True View- ) No Yes 

"?or image file (TIF, GIF, )PG) No Yes (except Single-Click Linear Takeoff) 

21 
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QTO generates quantities for model objects by extracting their embedded design data and mapping it to dimensio 

in the catalog. As you work, notice that some dimensions are mapped automatically, based on item type. The ite 

type defines the primary dimension of the item; for example, by default, Linear items are mapped to Length. Eac 

dimension is also mapped to a default object property, which is the property that is measured during takeoff. Default. W --f 
object properties are specified on the Mapping tab of the Preferences dialog. By default, linear objects are mappe 

:o the Length property. Therefore, if a linear object contains a Length property; the length of the object is measure 

::-eponed during takeoff. 

•me Linear objects, such as interior walls, have additional linear properties, such as Width and Unconnected Height. 

When additional properties are available for an object, they display in the dimension columns. You can select a different 

roperty to change dle ?ropert)· that is measured during takeoff. 

Some objects do not contain the default property. In this case, the primary dimension value is Undefined on the Takeoff 

palette and no measurement can be generated fo r the object. By specifying a property for the primary dimension, x_ou 

can generate a takeoff measurement for the obj ect . If an object does not contain a mappable property, you must enter 

an override in the Workbook to create a measurement fo r the object. 

!Ell Automatic Takeoff Tools 

Use automatic takeoff tools with 3D DWF models and 2D DWF sheets. These tools create takeoff data using the design 

data embedded in the DWF files by publishing applications. These tools are: 

• Model Takeoff: This tool, which can be used only with 3D DWF files, extracts the object tree from the model 

and adds it to the Takeoff palette. The items that are created by the Model Takeoff tool are placed in a takeoff 

group whose name is based on the model name. You create valid takeoff for these items by dragging them to a 

defined area (root, group, or item) on the Takeoff palette. 

• Search Takeoff: This tool, which can be used with 3D models and 2D sheets, creates takeoff data for multiple 

items based on search criteria you define. Using the tool, you select a piece of geometry on a sheet and specify 

search criteria based on the object's design data. The software finds all objects in the project that match the 

search criteria. The geometry and properties for the objects are loaded into the Takeoff palette item. Select an 

item on the Takeoff palette prior to starting a search takeoff to have the results added to that item and named 

based on the item's family or style. 

• Single-Click Auto Takeoff: This tool, which can be used with 3D models and 2D sheets, lets you create a 

takeoff measurement with a single click on a piece of geometry. 

!E1J Manual Takeoff Tools 

Manual takeoff tools can be used with 2D DWF sheets and non-DWF files, such as PDF and TIF files. They measure 

drawing geometry to create takeoff data. These tools are: 

• Linear Takeoff: This group of tools lets you record linear measurements by tracing lines on a floor plan. Using 

the Single-Click Linear Takeoff tool, you can create a linear measurement by clicking on a line. 

• Area Takeoff: This group of tools lets you record area measurements by tracing geometry on a floor plan. 

• Count Takeoff. Use this tool to tally and record occurrences of objects, such as windows and doors, that you 

want to quantify on a floor plan. 

• Backout Takeoff. This group of tools lets you refine takeoff data by subtracting from previously recorded 

counts or measurements. lUI 
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Specifying Sheet Sca le 

=- files have a scale that is set when the file is published. That scale is reflected in the measurements that are calculated 

,JJmU:. displayed in QTO. You cannot change the scale of a drawing when the scale is set by the authoring application. 

DFs and image files (TIF, GIF, JPG), you must specify the sheet scale before you can use the manual takeoff 

tt ' or linear or area measurements. Without a sheet scale, only the Count Takeoff tool is available. You can select 

efined scale, if known, or set the precision manually by plotting points in a drawing. 

n· th DWF and non-DWF files, you can specify drawing units. 

11'~·'dejined scale for an image file 
OocumentP ·~ 

lll 

Ill' can select a predefined scale for an image file, if the scale 

original drawing is known to you. 

On the Documents palette, select the image file, right­

click, and click Properties. 

In the Document Properties dialog, click the Units and 

Scale tab and select the following. 

• Scale Style = Engineering. 

• Drawing Units = Millimeters. 

• Sheet Scale = <select the suitable scale> and click 

OK (Figure 50). 

l Scale 

:ou do not know the scale of the original drawing, set 

Scale Sl'Jie: 

I Engineertng 

Drawing Units: 

LJ Apply to all sheets in this project. 

Sheet Scale: 

Custom Scale 

CL<Stom Scale 

IL1 ----'1 Ll50 ___ _, 

[ Set scale by plotting points ... j 

!lntu•· ~ ' e of the image file manually by plotting points in the 

Specifying the scale calibrates the manual takeoff tools 

·e distortions in scanned image files. 

O n the Units and Scale tab of the Document Properties 

dialog: 

For Drawing Units, select a unit. 

- In the Sheet Scale select 'Custom: 

- To make this drawing unit the default for the project, 

select Apply to all sheets in this project. 

Click Set scale by plotting points (Figure 51). 

In the Set Scale by Plotting Points dialog, for Baseline 

Segment Length, enter the 'known dimension of an object. 

On the canvas, trace the size of the object as the baseline 

segment . QTO records the measured length of the 

OK II Cancel I[ Apply 

Fig 50: Units and Scale for an Image file 

Enter a baseline segment length. and then specify start and end 
points for the measurement on the canvas. 

Baseline Segment Length: 

Measured Segment Length: 

Calculated Scale: 

OK I I Cancel 

Fig 51: Set Scale by Plotting Points 

segment, and calculates the scale of the drawing. If you change the length or unit of measure of the baseline 

segment, the scale calculation updates dynamically. 

ecifyi ng Drawi ng Units 

has both drawing units and display units. Drawing units are specified at the sheet level, as explained in 

s;.e::~:m .. Display units, which are the units displayed in takeoff measurements on drawings, are specified at the 

<el.. 
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Drawing units are the units of measurement for a sheet. The value you specify 

Typical values are inches, centimeters, and millimeters. For example, an o-li.IU.L 

':<ming units is based on paper size. 

· :0- inch drawing uses inches for 

drawing units. For scanned drawings, the drawing units are determined by che size of m e original sheet. The ratio o 

paper size to real-world units represents the scale of the drawing. For example, a one- inch object on a sheet with a 

scale of 1" = 100' represents a real- world object that is 100 feet long. When you specify drawing units for a sheet, you 

can apply the units to all sheets in the project. , 

To specify drawing units 
1. On the Documents palette, select a drawing. 

2. Click Document menu » Units and Scale. You can also select the drawing, right- click, and click Properties to 

open the Document Properties dialog. 

3. On the Units and Scale tab of the Document Properties dialog, for Drawing Units, select a unit of measu,re. 

4. If you want the drawing unit applied to the entire project, select Apply to all sheets in this project. 

HANDS-ON 

• File menu » Import » Sheets & Models. 

• Select 'Al01 - Entry Level & Upper Level1_m.pdf' from 'C:\Program Files (x86)\Autodesk\Quantity Takeoff 

2013\Help\Getting Started (Metric)' and import. 

• On the Documents palette, select the image file. 

• On the canvas, zoom in to the south entry door (Figure 52). 

• Click Document menu Units and Scale. 

• In the Document Properties dialog, set the following: 

• Drawing Units = Millimeters 

• Select 'Scale by plotting points' 

• In the Set Scale by Plotting Points dialog, for Baseline Segment Length, enter 1830, and select Millimeters. 

• On the canvas, trace the width of the south entry door as the baseline segment by clicking to specify the 

start point and clicking again to specify the end point (Figure 53 ). 

Fig 52: PDF file 

~'· _ x_ 
----

Enter a baseline segment length. and then specify start and end 
points for the measurement on the canvas. 

Baseline Segment Length: 1830 I Milineters ... j 
Measured Segment Length: 0.32795 mm 

Calculated Scale: 0.00018:1 

OK j [ Cancel 

Fig 53: Scale by Plotting Points 

QTO records the measured length of the segment and calculates the scale of the drawing. If you change the length or 

unit of measure of the baseline segment, the scale calculation updates dynamically. 

24 

• Click OK. In the Document Properties dialog, the 

calculated scale displays as the value for Custom Scale 

(F :; t ~ ). 

• Click OK. 

Custom Scale 

Custom Scale 

0.00018 1 

[ Set scale by plotting points ... ] 

ig .r; . Scale 
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2. MANUAL TAKEOFF TOOLS 

Manual takeoff tools can be used with 2D DWF sheets and non-DWF files, which include DWGs, 

PDFs, TIFs, GIFs, and JPGs. This takeoff method is sometimes called on-screen takeoff. They measure 

drawing geometry to create takeoff data. These tools are: 

• Linear Takeoff: This group of tools lets you record linear measurements by tracing lines on a 

floor plan or, in the case of the Single-Click Linear Takeoff tool, by clicking on a line. 

• Area Takeoff: This group of tools lets you record area measurements by tracing geometry on 

a floor plan. 

• Count Takeoff: This tool lets you tally and record occurrences of objects, such as windows and 

doors, that you want to quantify on a floor plan. 

• Backout Takeoff: This group of tools lets22 you refine takeoff data by subtracting from previously 

recorded counts or measurements. 

Note: All sheets require a scale in order for takeoff tools to be used. DWF files contain a scale that is set 

when the file is published. For PDFs, TIFs, and other image files, you must specify the sheet scale before 
you can use manual takeoff tools for linear or area measurements. Without a sheet scale, only the Count 

Takeoff tool is available. 

~ Count Takeoff Tool 

The Count Takeoff tool tallies the occurrences of a particular object on a DWF or non-DWF floor plan 

and creates takeoff for each occurrence of the object. Use this tool to create takeoff for objects, such as 

\'indows and doors, that have a Count item type. If you select a non-Count item, a message displays 

to notify you of the mismatch between the tool and item type, and any takeoff objects you create are 

placed in a Count item at the root of the Takeoff palette. To perform a count takeoff 

1. Open the floor plan that contains the objects you want to count, and zoom in if necessary. 

2. On the Takeoff palette, select the corresponding Count takeoff item. 

3. On the toolbar, click Count Takeoff. 

On the Contextual Tools palette, modify the color, opacity, count symbol, and symbol size, as 

needed. The Color and Opacity values you specify are applied both to the color block on the 

Takeoff palette and the count symbol that is added to the canvas. 

S. On the canvas, select each object to include in the takeoff item. Each time you select an object, a 

count symbol is placed on the sheet, and a takeoff object is recorded both on the Takeoff palette 

and in the Workbook. 

25 
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The new takeoff objects inherit the item type and name of the selected item. As the objects are created, a numerical 

suffix is added to prevent duplicate names. 

Note: To make it easier to select objects, turn off the visibility of any existing takeoff m arkup using the ShowfHide 

functionality on the Takeoff palette. 

Note: If the item you selected on the Takeoff palette does not have a Count item type, a message displays when you select 

the first object on the floor plan . In the message box, click OK. The Count takeoff object cannot be added to the non-Count 

item you selected; therefore, QTO adds the object to a Count item at the root of the Takeoff palette. You can continue 

selecting objects on the floor plan, and they will be added to the newly created Count item. On the Takeoff palette, this 

item is listed in the Description column as Count. Either rename the item and define its properties as needed, or drag the 

objects to the appropriate item and delete the empty Count item. · 

To rename takeoff objects for easier identification, do one of the following: 

• On the Takeoff palette, select an object, and then click the Description value to enter editing mode. Enter' a 

new name, and press ENTER. 

• On the Takeoff palette, double- dick a takeoff object. In the Takeoff Object Properties dialog, enter a descriptive 

name for the object, and click OK. 

IHANDS-ON: JOINERY DE'I'_~IJ- PREPARATIQ~fE9~_A .rDL~ 
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• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name 

• Unit System 

• Currency 

• Catalog 

= Count Takeoff 

=Imperial 

= Rs. 

=None 

• Import Files = Select the given file '2D Plan.PDF 

"'I Tllk:ooff ll_..t j LestModi&d 
17-ll9-:10l3 10:39:00 

0 0 17.()9-:1013 10:39:00 

=· 

Fig 1: 2D Plan 

• Set the 'Scale' for the document as follows. 

• Document menu » Units and Scale 

Scale Style = Engineering 

Drawing Units = Feet 

Sheet Scale = Custom ( F1g~ re 2) 

--

• Select 'Set Scale by Plotting Points' option and select two points on the canvas to measure the width of the 

Hall (room inside dimension) and set the Baseline Segment Length as 16' (Figure 3). 
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S.t Scale by Plotting Points 

Enter a !Mseline segment length. and thtn speocift start ond end 
points for the measurement on the canvas. 

S.sel;ne Seo-t lengtho 16 

Me..uoed Seo-t Lengtho 3.34263 ft 

Calcufllted Scale: o.zossu 

~~ 

I~ 
0 \V 

Fig 2: Set Scale 
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WBS "' 
't' Joinery Details 

0 
01 
02 
v 
w 
Wl 

Description 

JOOery Details 
Door 4' X7' 
Door 3' X 7' 
Door 2'6" X 7' 

Wndow5'X4' 
Wndow4' X4' 

fig 3 W BS 

Type 

Count 
Count 
Count 
Count 
Count 
Count 

Select the item 'D' and activate the 'Count Takeoff' tool. Set the Symbol (shape, Color and Size) as per the 

requirements and pick a point near the 'D' door . 

W~ndow4' X4' 

Count 
Count 
Count 

Count 
Count 

Fig 4· Count Takeoff 

D 

In the 'Takeoff Items Properties' of the 'D' group, enter the values fo r the material and labor costs ( gure ~ ) . 

Customize the Workbook columns to get the following report (Figu"'e 6). 

Cost Computation 

Material Cost 

9.000.00 X I Qty 1 (Count) · I 
Labor Cost: 

1.000.00 X IQty 1 (Count) · I 
Subcontractor Cost 

x i.._ ___ __,~ I 
Equipment Cost 

X [.___ ___ _j• l 

Fig 5: Cost 

Joinery Details j I 1 
~~~ J-oi-nery-'--Det- ai-ls-.0----+:-=· =-Do-o-r-4'_X_7 __ t:1.000~ 

,__ 

WBS + I Oescriptioo Quantity 1 I 

Fig 6: Workbook 

In the same way complete the 'counting for other doors, windows and ventilators. 

Total Cost 

10.000.00 
10.000.00 

l;I @j .. ----· 
Type ' 

c;ou,t 
c;ou,, 

t 

WIOdow 4'X4' (6) Coc.nt 

Joinef}' Deta;Js 
- · r------:-N ·-

. Jo~efY __[)eta;Js.D 

Description I Quantity 1 

D<lor4' X 7' 
. --+ 

1.000 ea 

Total Cost I 
76.900.00 
10.000.00 

D<lor 3' X T 2.000 ea 15.800.00 -------
.:!_oinef}' o~as .D2 [)Q~ 2'6' ' XI._--i--2.000 ,ea I 13.800.00 I 

- JoinefY Details.¥ . Ventilator 'Z X 2' 2.000 ea 4.600.00 
JoinefY Det~a~ .w - -- 1 W~ndow 5' X4;- -r:::::J;ooo ~ 1 · 9.000.00 

1 
Joinef}' Deta;Js.Wl Window 4' X 4' 1 6.000 I ea . 23.700.00 

Fig 7: Count Takeoff & Workbook 

27 



cAuu· 
CENTRE 

f)ll] Single-Click Linear Takeoff Tool 

You can use the Single-Click Linear Takeoff tool on DWF and DW G files, but not on PDF and image files. 

1. Open the floor plan that contains the linear objects you want to measure, and zoom in if necessary. 

2. On the Takeoff palette, select the corresponding Linear takeoff item. 

3. On the tool bar, click Single-Click Linear Takeoff. 

4. On the Contextual Tools palette, modify the Color and Opacity values, if desired. 

s. On the canvas, select each object to include in the takeoff item. 

Chapter 

Each time you select an object, a takeoff object is recorded both in the Takeoff palette and in the Workbook. In the 

summary view of the Workbook, the total length of the takeoff objects displays in the Quantity 1 column for the item. 

In the detail view of the Workbook, the Length column displays the length of each object below the item total. If the 

item you selected on the Takeoff palette does not have a Linear item type, a message displays when you select the first 

object on the floor plan. In the message box, click OK. The Linear takeoff object cannot be added to the non-Linear 

item you selected; therefore, QTO adds the object to a Linear item at the root of the Takeoff palette. You can COJiltinue 

selecting objects on the floor plan, and they will be added to the newly created Linear item. On the Takeoff palette, 

this item is listed in the Description column as Linear. Either rename the item and define its properties as needed, or 

drag the objects to the appropriate item and delete the empty Linear item. 

DfJ Using Linear Takeoff Tools to Trace Geometry 

For PDFs and image files, such as TIFs, you must specify the sheet scale before you can use linear takeoff tools to trace 

drawing geometry. 

1. Open the floor plan that contains the linear objects you want to measure, and zoom in if necessary. 

2 . On the Takeoff palette, select the corresponding Linear takeoff item. 

3. On the tool bar, click the linear takeoff tool that is appropriate for the geometry you need to trace: 

a. Polyline Linear Takeoff Tool (for lines and arcs) 

b. Rectangle Linear Takeoff Tool 

c. Ellipse Linear Takeoff Tool 

4. On the Contextual Tools palette, modify the tool options, if desired. 

s. If turning off Snaps would make it easier to trace geometry, click Takeoff menu » Snap to Point. 

Note: To pan the drawing when you are in the process of tracing geometry: Press and hold the SPACEBAR to switch the 

takeoff tool to Pan mode, and pan the drawing until the geometry you need is in view. Release the SPACEBAR to return the 

takeoff tool to its original state, and complete the takeoff measurement. 

6. On the canvas, trace the linear object: 

a. Polyline tool: Draw line segments, arc segments, or a combination of line and arc segments. You can switch 

between line and arc mode while drawing a continuous polyline. 

b. Rectangle tool: Click to specify the start point, move the cursor to the opposite corner of the rectangle, 

and click to specify the end point. 

c. Ellipse tool: Click to specify the start point, move the cursor to the opposite extent of the ellipse, and click 

to specify the end point. 

Each time you create an object, the takeoff object is recorded both in the Takeoff palette and in the Workbook. In 

the summary view of the Workbook, the total length of the takeoff objects displays in the Quantity 1 column for the 

item. In the detail view of the Workbook, the Length column displays the length of each object below the item total. 
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akeoffTool 

you with several area takeoff tools, all of which create area measurements from geometry on a floor 

tools to create takeoff for items, such as rooms and flooring that have an Area item type. If you select 

::tern, a message displays to notify you of the mismatch between the tool and item type, and any takeoff 
1- oeate are placed in an Area item at the root of the Takeoff palette. 

image files, such as TIFs, you must specify the sheet scale before you can use area takeoff tools to trace 

ea-y. 

e floor plan that contains the area objects you want to measure, and zoom in if necessary. 

akeoff palette, select the corresponding Area takeoff item. 

'tool bar, click the area takeoff tool that is appropriate for the geometry you need to trace: 

- e Area Takeoff Tool 

"""'"''c.LG.u;a=;.te Area Takeoff Tool 

.\rea Takeoff Tool 

·as, trace the area object: 

:.;:~:Jorli.'ne tool: Draw line segments, arc segments, or a combination ofline and arc segments. You can switch 

121rw'een line and arc mode while drawing a continuous polyline. 

~..._.~~e tool: Click to specify the start point, move the cursor to the opposite corner of the rectangle, 

dick to specify the end point. 

:se t ool: Click to specify the start point, move the cursor to the opposite extent of the ellipse, and click 
~ specify the end point . 

:::lili!!tz:::ed estimate of part of a wall of a building from the given section view. Assume 

f' 8). 

l:Sf~ifica.Jtions: 

·"'"'""""'"'-'Uil concrete shall be of Lime Concrete. Cost = Rs. 1000/m3
• 

and Plinth shall be of 1 sr class brick work in lime mortar. Cost= Rs. 900/m3
. 

Course: 3mm c.c. with water proofing compound. Cost = Rs. 100/m2
• 

e::::st::r!!Q] e: P' class brick work in lime mortar. Cost = Rs. 320/m 3
• 

't::::::i:s!:~)~ 12cc cement plastered. Cost = Rs. 50/m2
• 

d Plinth = Volume X Cost 

~ -- 0.2) + (0.5 X 0.2) + (0.4 X 0.8)) X 900 

f Course = Area (Length X Breadth) X Cost 
.- 100 

~ 
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f)IIJ Single-Cl ick Linear Takeoff Tool 

You can use the Single- Click Linear Takeoff tool on DWF and DW G files. but no~ on PDF and image files. 

1. Open the floor plan that contains the linear objects you want to measure, and zoom in if necessary. 

2 . On the Takeoff palette, select the corresponding Linear takeoff item. 

3. On the toolbar, click Single- Click Linear Takeoff. 

4. On the Contextual Tools palette, modify the Color and Opacity values, if desired. 

5. On the canvas, select each object to include in the takeoff item. 

Each time you select an object, a takeoff object is recorded both in the Takeoff palette and in the Workbook. In the 

summary view of the Workbook, the total length of the takeoff objects displays in the Quantity 1 column for the item. 

In the detail view of the Workbook, the Length column displays the length of each object below the item total. If the 

item you selected on the Takeoff palette does not have a Linear item type, a message displays when you select the first 

object on the floor plan. In the message box, click OK. The Linear takeoff object cannot be added to the non- Linear 

item you selected; therefore, QTO adds the object to a Linear item at the root of the Takeoff palette. You can continue 

selecting objects on the floor plan, and they will be added to the newly created Linear item. On the Takeoff p,alette, 

this item is listed in the Description column as Linear. Either rename the item and define its properties as needed, or 

drag the objects to the appropriate item and delete the empty Linear item. 

fJfJ Using Linear Takeoff Tools to Trace Geometry 

For PDFs and image files, such as TIFs, you must specify the sheet scale before you can use linear takeoff tools to trace 

drawing geometry. 

1. Open the floor plan that contains the linear objects you want to measure, and zoom in if necessary. 

2. On the Takeoff palette, select the corresponding Linear takeoff item. 

3. On the toolbar, click the linear takeoff tool that is appropriate for the geometry you need to trace: 

a. Polyline Linear Takeoff Tool (for lines and arcs) 

b. Rectangle Linear Tal<eoffTool 

c. Ellipse Linear Takeoff Tool 

4. On the Contextual Tools palette, modify the tool options, if desired. 

5. If turning off Snaps would make it easier to trace geometry, click Takeoff menu » Snap to Point. 

Note: To pan the drawing when yo u are in the process of tracing geometry: Press and hold the SPACEBAR to switch the 

takeoff tool to Pan mode, and pan the drawing until the geometry you need is in view. Re lease the SPACEBAR to return the 

takeoff tool to its origi nal state, and com plete the takeoff measure ment. 

6. On the canvas, trace the linear object: 

a. Polyline tool: Draw line segments, arc segments, or a combinat ion ofline and arc segments. You can switch 

between line and arc mode while drawing a continuous polyline. 

b. Rectangle tool: Click to specify the start point, move the cursor to the opposite corner of the rectangle, 

and click to specify the end point. 

c. Ellipse tool: Click to specify the start point, move the cursor to the opposite extent of the ellipse, and click 

to specify the end point. 

Each time you create an object, the takeoff object is recorded both in the Takeoff palette and in the Workbook. In 

the summary view of the Workbook, the total length of the takeoff objects displays in the Quantity 1 column for the 

item. In the detail view of the Workbook, the Length column displays the length of each object below the item total. 
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fJ6I) Area Takeoff Tool 

QTO provides you with several area takeoff tools, all of which create area measurements from geometry on a floor 

plan. Use these tools to create takeoff for items, such as rooms and flooring that have an Area item type. If you select 

a non- Area item, a message displays to notify you of the mismatch between the tool and item type, and any takeoff 

objects you create are placed in an Area item at the root of the Takeoff palette. 

For PDFs and image files , such as TIFs, you must specify the sheet scale before you can use area takeoff tools to trace 

drawing geometry. 

item. To use an area takeoff tool 

li the 

e fi rst 

- Linear 

tinue 
-palette, 

1. Open the floor plan that contains the area objects you want to measure, and zoom in if necessary. 

2. On the Takeoff palette, select the corresponding Area takeoff item. 

3. On the toolbar, click the area takeoff tool that is appropriate for the geometry you need to trace: 

a. Polyline Area Takeoff Tool 

b. Rectangle Area Takeoff Tool 

ed, or c. Ellipse Area Takeoff Tool 

s m trace 

itch 

gle, 

click 

. In 
" ,.. the 

total. 

4. On the canvas, trace the area object: 

a. Polyline tool: Draw line segments, arc segments, or a combination of line and arc segments. You can switch 

between line and arc mode while drawing a continuous polyline. 

b. Rectangle tool: Click to specify the start point, move the cursor to the opposite corner of the rectangle, 

and click to specify the end point. 

c. Ellipse tool: Click to specify the start point, move the cursor to the opposite extent of the ellipse, and click 

to specify t[le end point. 

HANDS-ON 

Prepare a detailed estimate of part of a wall of a building from the given section view. Assume 

the length as 6m (Figure 8). 

General Specifications: 
• Foundation concrete shall be of Lime Concrete. Cost = Rs. 1000/m3

• 

• Foundation and Plinth shall be of 1'1 class brick work in lime mortar. Cost= Rs. 900/m3
• 

• Damp Proof Course: 3mm c.c. with water proofing compound. Cost= Rs. 100/m2
• 

• Superstructure: 1'1 class brick work in lime mortar. Cost = Rs. 320/m3
• 

• Wall finishing: 12cc cement plastered. Cost= Rs. 50Im2
• 

Manual Calculation: 

Cost of Foundation Concrete= Volume X Cost 

= 6 X 0.8 X 0.3 X 1000 

= Rs. 1,440/-

Cost of Foundation and Plinth = Volume X Cost 

= 6 X ((0.6 X 0.2) + (0.5 X 0.2) + (0.4 X 0.8)) X 900 

= Rs. 2,916/-

Cost of Damp Proof Course = Area (Length X Breadth) X Cost 

= 6X0.4X 100 

= Rs. 240/-

~ 
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Cost of Superstructure = Volume X Cost 

= 6 X 0.3 X 3.5 X 320 

= Rs. 2,016/-

Cost of Cement Plaster= Wall Area (2 sides) X Cost 

= 6 X 3.5 X 2 X 50 

= Rs. 2,100/-

Total Cost= Rs. 8,712/-

Autodesk Quantity Takeoff 

• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name = Wall Section 2D DWF 

• Unit System = Metric 

• Currency = Rs. 

• Catalog= None 

• Import Files= Select the given file 'Wall Section.dwf' (Figure 9). 

• Goto 'Document menu » Units and Scale' and set the following. 

• Scale Style = Engineering 

• Drawing Units = Centimeters 

• Sheet Scale = Published 

• Switch to 'Takeoff' palette and create an item called as 'Foundation Concrete: Set the type as 'Area' (Figure 10). 

Takeoff [,! 1§1 
[View All = ... 

Fig 9: Wall Section Fig 10: Takeoff 

• Select the created item and use the 'Rectangle Area Takeoff' tool to select the foundation concrete area as 

follows (Figure 11). 

• In the 'Takeoff Properties' dialog box of the foundation concrete item do the following. 

• General tab 

Thickness = 6 m 

• Cost Data tab 

Quantity 2 = Volume 

Material Cost= Rs. 1,000 X Qty 2 (Vol) (Figure 12). 
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I I I General I Asaentlly I Cost Data '-------! 

~~!";~{·"· .. ,: . . . -- ~ -~.-· ~ ~ 
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. . . 

Fig 11: Foundation Concrete Area Takeoff 

Cost Quant~ies 

Quantity 1 (Qty 1): 

jArea 

Quantity 2 (Qty 2): 

lvoUI1e 
Tome 
Time: 

Cost Comput!!lion 

Material Cost: 

Unit: 

· I lm• 
Unit: 

· I lm• 

1.000.00 X I Qty 2 (VoUne) · I 
Fig 12: Cost Data 

• In the workbook, remove the unwanted fields and add the Quantity 2 and Total Cost fields. Cross check the 

result with the manual calculation results. 
!workbook 
10 e I \'1/all Section-Model 
' .. 

·I~ Foundation Concrete 

• In the same way create the item for 'Foundation and Plinth: 

Takeoff 

~@~ !view All d f£J 
~0 WBS "' Description 

~ • Foundation and Plinth Foundation ... 

~0 Foundation and Pli... Foundation ... 

~ Foundation and Pli ... Foundation ... 

"' ~ Foundation and Pli... Foundation ... 

~0 • Foundation Concrete • Foundation ... 

~ Foundation Concre ... • Foundation ... 

Fig 1.4&15: Foundation and Plinth Area Takeoff 

E) 8 I \'1/all Sedion-Model 

~---] fx 

I I WBS ~ Descriptim I Quantity 2 

I 
Foundation Concrete ' . Foundatoon concrete 1.439 m' 

_-__ ~ion~ 1 Foundatoon and Plint_i:l _ 2_242 1 m' 

Fig 16: Foundation and Plinth Cost 

Total Cost I 
1.439.35 

... ~18.00 

4\ IIJ 
=· 

Area 

Area 

Area 

Area 

Area 

Area 
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• In the 'Takeoff' palette, create a new item for 'Damp Proof Course' and set the type as 'Linear: 

• Select the item and select the damp proof course's width with the help of 'Single Click Linear Takeoff' tool 

as shown in the below image. 
go ... @ r::':! ... , -, A 

! 5mgle-Ct1Ck U~ear Takeo~ (~) J 
Fig . 7 Single Click Linear Takeoff 

T* off 

Damp Proo1 Course.Oamp "toof Course_1 0 

~ ~ 

Fig 18&19: Damp Proof Course 

• In the 'Takeoff Item Properties' of the damp proof course item, set the following. 

• General tab 

Height= 6 m 

• Cost Data tab 

Quantity 2 = Area 

Material Cost= Rs. 100/Qty 2 (Area) (Figure 20) 

.'l- IQJ 

• Like the 'Foundation Concrete; find the Quantity and Cost for the Super Structure (Figure 21&22). 

IWO<kbook 

00 I Wall Section·Mode::.:l--:--.---------------
h !

Worlcbook 

!00 1 Wall Section·Model 

h I was Deocriplioo I Quanti ty 2 I T otol Cost I . 

was Deocriplioo Quantity 2 I Toto! Cost 

Focndlllion Concrete • Foundlllion concrete 1.439 lm' 1 1,439.35 ' 
I Focndlllion eona.te . Focndlllion concrete 1.439 m' 1.439.35 

. Focndlllion and Ptirih -~and Plinth 3.·m+;;;, I 2,918.00 

foundation and Pli1th liJ Foundation and Pli1th 3.242 lm' 2.918.00 
o,.,.., Proof Couse • o,.,.., Proof Couse 2.401 lm' I 240.09 ·I 

. Domp Proof Couse . o,.,.., Proof Couse 2.401 , m' i 240.09 

_ .... L~Sir\Jcture ! .. _Super~..-.--'. 6.317 ' m• l 2,021.55 

Fig 20: Workbook Fig 21: Super Structure Area Takeoff Fig 22: Super Structure 

• In the 'Takeoff' palette, create an item called as 'Plastering' and set the type as 'Linear: 

• Select the item and select both sides of the Super Structure with the help of 'Single Click Linear Takeoff' tool. 
Ttttort .!,\ II 

liil@@ 1- " iil0 
~- · - I T"" C'J 0 .. Ollq!PmafCcuw . o.q,Proo_ · ~ - -

0 • Fo.mlticnlndl'hh -.~-

6.317 m• 
0 ·· ~,.._,iiiiii' ~c..-ijiii::&~·~....-.iii!'il' j;a~~-.. 0 ·~ 
0 ....... , • - ...... Super 
0 
0 .. ~Sl!l.cbn -~~N 

...... 
Fig 23: Plastering 
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In the 'Takeoff Item Properties' of the plastering item, set the following. 

• General tab 

Height= 6 m 

• Cost Data tab 

Quantity 2 = Area 

Material Cost ~ Rs. 50/Qty 2 (Area) 

• Create a group and add all the items into the group. 

Takeoff ~ (§ Worid>oolt 

1 @),;;;@;:@~;;1 \fl;;;;'ew;;;;• ;;;;Al;;;;l ;;;;;;;;;;;;;;;;;;;;;;;;~d;;; ... ~0~==r====~~ 00 1 l 'h!IISection-Modet 
If. ...-- ___,. 
~ ~ :& WBS "' Description 

~ " Estimation and Costing Cost (8) 

~ .,. Damp Proof Course . Damp Proo ... 

~ ... Foundation and PL Foundation ... 

~ .,. Foundation Concrete • Foundation ... 

~ .. Plastering • Plastering (2) 

~ .,. Super Structure ·S~Stru .. . 

fJI3 Backout Takeoff Tool 

Type 

Linear 

Area 

Area 

Linear 

Area 

WBS 

'I' Emnolion ond Cooling Cos! 
-'---1 ~;;;i Cooling 1'10~~~- II P~ering 

Estimation and Cosling.Super Structure . Sup,;;: Structure 
Estimalion and Sosiing .Founclati~ Co... . Foundation conerete 
Estimotion and Cosiing.Foundalion on ... · Found.;tion .,d.Pti.;ih .. _ 
Estimation ond Cosiing.Oomp Proof Co_"' ... ~_Proof (;DUlSe_ 

Fig 24: Group 

6.317 m1 

1.439 m' 

3.242 m' 
2.401 m' 

~-----+ 

2.021 .55 
1.439.35 
2.918.00 
.. 240.09_ 

Use the backout tools in QTO to refine takeoff data by subtracting from a previously calculated measurement or count. 

For example, after using a linear takeoff tool to calculate the length of a wall, you could use a backout tool to trace a 

door opening in the wall, which would subtract the opening from the wall measurement. 

Note: As an alternative to using a backout tool, you can use grips to manipulate the shape of a takeoff area, adding or 

removing points along the takeoff boundary as needed. While pressing CTRL, click on a line to add a new point, or click on 

a point to remove it. Then , click the Select tool , and use the grips to manipulate the takeoff area shape. 

To use a backout takeoff tool 

1. Open the floor plan that contains the object you want to measure, and zoom in if necessary. 

2. If the backout you create will cut an object into 2 or more pieces (such as subtracting a door opening from a 

wall measurement), on the Takeoff palette, select the object to modify. 

3- On the toolbar, click the backout takeoff tool that is appropriate for the subtraction you want to make: 

4. 

a. Polyline Backout Takeoff Tool 

b. Rectangle Backout Takeoff Tool 

c. Ellipse Backout Takeoff.Tool 

d. Count Backout Takeoff Tool 

On the canvas, trace backout geometry, or select a count symbol: 

a. Polyline tool: Draw line segments, arc segments, or a combination of line and arc segments. You can switch 

between line and arc mode while drawing a continuous polyline. 

b. Rectangle tool: Click to specify the start point, move the cursor to the opposite corner of the rectangle, 

and click to specify the end point. 

c. Ellipse tool: Click to specify the start point, move the cursor to the opposite extent of the ellipse, and click 

to specify the end point. 

d. Count tool: Select the count symbol for an object to subtract the object from the item total. 
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HANDS-ON:ESTIMATIONANDCOSTINGOFA \VALLBYUSING2DDWF 

Prepare cost estimation for the wall as shown in the following figure (units are in mm). Assume that the wall has 12mm 

plastering on both the sides (Figu e 25). 

• Openings 

• Door = 1.2m X 2.1m 

• Window= 1.2m X 1.2m 

• Material Cost 

• Masonry= Rs.320im3 

• Plastering= Rs. 30Im 2 

• Labor Cost 

• Masonry= Rs. 601m3 

• Plastering= Rs. 20Im2 

Manual Calculation 

Wall Volume 

Volume of Masonry 

Cost of Masonry 

Area of Plastering 

Cost of Plastering 

Total Cost 

= 6.334 m3 

= 5.727 m3 

= Rs. 2,176.331-

= 55.08 m 2 

= Rs. 2,7541-

= Rs. 4,930.331-

Autodesk Quantity Takeoff 

r---

D 
9000 

J\ I 

Fig 25 

• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name =Wall 2D DWF 

• Unit System =Metric 

• Currency 

• Catalog 

• Import Files 

= Rs. 

=None 

= Select the given file '2D Wall Elevation View Scale1_50.dwf' (Figure 26). 

• In the Document Palette, select and change the Items name as 'Elevation' (Figure 26). 

~ 

230 

r 

.,.. I Takeoff I L 

f~~.~~.~----] 0 

Fig 26: Import Files Fig 27: Document 

• Double click on the 'Elevation' sheet to open the same in the canvas. 

• Goto 'Document menu » Units and Scale' and set the following. 

• Scale Style = Engineering 

• Drawing Units= Millimeters 

• Sheet Scale = Published (figLre 28) 
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Switch to 'Takeoff' palette. 

• File menu » Import » Catalog 

• Select and import the 'Wall' catalog which was created in the previous hands-on. 

• Change the cost of Masonry and Plaster items as given in this problem. 

• Change the 'Standard Wall' item type from 'Volume' to 'Area' (As we have the 2D DWF, we able to measure the 

area takeoff from the given model). 

• Select 'Yes' in the Alert dialog box (Figure 29). 

• Open the 'Standard Wall' takeoff item properties and set the formula to calculate the Masonry and Plaster as 

follows. 

• Masonry= Volume X 0.904 

• Plaster = Area X 2 (Figure 30) 

Document 

Scale Style: 

IEngineemg 
Orev.ing Units: 

- -- -- - -~ 
One or more items in your selection are used 
as an assemblylcomponent. Changing the l>f pe 
v.ill reset the formula in each referencing 
component to 0 for each assembly. k e you 
sure you want to change the type? 

0 Apply to all sheets in this l>foject EJ Do not show this dialog again. 

Yes I I No 
Sheet Seale: 

IP1.bished 

Fig 28: Units and Scale Fig 29: Alert 

General Assembly '--1 Co_ st_ Dat_a_ l.___ ____ _ 

r±JB 

• Select the 'Standard Wall' item in the Takeoff palette. In the tool bar, select 'Rectangle Area Takeoff' tool and 

pick two points dia&onally in the canvas to select the wall. 

Fig 31: Area Takeoff Fig 32: Area Takeoff 

• In the toolbar, select 'Rectangle Backout' and draw rectangles to remove Door and Window from the Area 

calculation. 

Fig 33: Backout Tools Fig 34: Area Calculation 
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• Open the 'Takeoff Object Properties' of the created object an G. set r_\e follo\\ing values (Figure 3 S ). 

• Check the 'Workbook' for the results (Figu,..e ~ ). 

General I Vtews I Properties I 

Area: 

I Volume: 

27.544m1 

6.335 m1 

l=ig 35: Thi ckness 

NA 
NA 

vJSS +l - .-... ~Cot! I Lillbor CCSt l 
:.bteost I Total Unit cost I Total Total Co!t 

"f Wal .... ..__, 3_4.85.52 1,445.4& 4.531.00 
'Y Wai.St&nd«dWIJJ Newlem~ ~rJ.t:. W 

~- MlttRI.Brlck-- New lem~ S-J""2i ., 
3.AS5.52 1.44.5.48 4.931.00 

m_~ U32.i6 60.00 .. "343.&4-.. 2. 176-:-.sG 
~ Ml!(ehi.PI&ster New lem Oe.::t.pi:n 55..:S2 a-1 X Jj 1.652.76 20.00 1,101.8.4 2.754.60 

Cost Estimation 

HANDS- ON: CALCULATE THE TAKEOFF FOR THE. GIVEN SI~lPLE STEP. 

1. Create a new project as follows. 
~ a. Name: Simple Step 

b. Unit System: Metric 

c. Currency: Rs. 

d. Catalog: None t .,, ' ' . ' II I:'.. ,• .::JJ1 
e. Import Files: Stair.DWF lsi 1so lsi 

2. Set the scale for the project. 

a. Documents menu » Units and Scale 

ii. Scale Style = Engineering 

iii. Drawing Units= Centimeters 

iv. Sheet Scale = Custom 

e. Use the 'Set scale by plotting points' option to set the scale ( Fi~ure .,,). 

3. In the 'Takeoff' palette, create a group called as 'Takeoff' with two items called as 'Concrete Foundation' and 

'Brickwork: Set the item type as 'Area' for both the items (Fig _,6 ). 

Ente< a baseline segment length. and then specify • tart and end 
points for the -urement on th.e canvas. 

Takeoff .l 

JCerone!en ... j l @@ 0 [viewAII a (£) 
:rot Basel ine Segment l ength: ·----·· 

Measured Segment Length: 1.525 em I~O WBS .,_ Description Type 

~0 "Takeoff New Group OeSCfiption 

~0 Brickwork New hem Description Area 

~0 Concrete Foundation • New hem Description Area 
-~"-'"'·-··-··-·· -··"···-

Caleulated Scale: OJ)5ll83:1 

OK ] [ Cancel 

Fig 37: Sca le Fig -:>8: Group with Ite ms 

4. Select the 'Concrete Foundation' item and use the 'Rectangular Takeoff' tool to measure the area as shown in 

the following image (Figure 39). 

s. Open the 'Takeoff Item Properties' of the 'Concrete Foundation' and set the thickness as 1.6 m. And set the 

Quantity 2 (in Cost Data) as Volume (Figt..re 40). 

36 

;:)0 
.. 1 ~""' I"""' 

New Goup o..a-. (1) ,.,.. 

l,! IQI 

Fig 39: Concrete Fou ndation Area 

TalcOoff ltom~ 

~ISS: 

Oescript;oo; 

Type; 

c;:;..,;;;e Foundotion 

~;a~~~.--------------

1"'-• Tl 
c;.,.,; I~ I CootD,.o 

llimens;on 

Th~kness: Unit 

1.6 (m ·l 

v.suaiDilplay 

Color. 

::. Takeoff Item Properties 
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6. Select the 'Brickwork' item and measure the step area with the help of 'Polyline Area Takeoff' tool. 

.-----
Takeoff 4\ gj 
®1@0 [View All a0 =· 
~0 was .,. Desa1>tion Type [b 
~g '!'Takeoff NewGroup~(2) 

~0 

,._ 
... I -:n 

~0 : . t • . • I · • • 

~g 'I' Conaele Fooodillion • New l em Descriptio ... we a 

~0 Concrete Foundali. .. • New Object DMcript ... Prea 

Fig 41 Brickwork Area 

7. Open the 'Takeoff Item Properties' of the 'Brickwork' and set the thickness as 1.5 m. And set the Quantity 2 

(in Cost Data) as Volume. 

8. Customize the workbook to show both the quantities. 
• Worl<book 

00 I Stair-Model 

W8S .,.I Descriptioo I Quantily 1 I Quantily 2 

'I' Takeoff New Group Desaiption 
___ .,.__ --·- - - - --- t-- ---~ 

Takeoff.Brickwori< New ~em Descnption 0.270 m' 0.404 m' 

Takeoff.Concrete Foundation . New ~em De~ion O.Oll5 m' 0.152 m' 

Fig 42: Workbook 

9. Hide the Takeoff group display by uncheck the 'Show/Hide' box in the takeoff palette. 

[ 
--

4' Takeoff 

~(§@~ 

~ 
[View All 

1100 WBS ... 
!i l!JO ,. Takeoff 

DO ,. Brickwork 

DO Brickwork_1 

I' DO ,. Concrete Fooodation 

ro Concrete Fooodati ... 

Description 

New Group Oescript;on (2) 

New kern Descriptio ... 

New Object Oescript... 

• New tern Descriptio ... 
• New Object Descript ... 

-
Type b 

I Area 

Area 
I 

Area 

! Area 
I 

.,. 
Fig 43· Show I Hide 

. .<I . 
.£1 .j <I 

. .(\• 

10. Create a group called as 'Plaster' with three items (Riser, Tread and Side) as shown in the following image 

(Figure 44). 

11. In the 'Takeoff Item Properties' of the Riser; 

a. In the general tab, enter the dimensions of the plaster (r gur. 4'1 ). 

General I hsernbly I Cost Data I 
Takeoff ~ Dimension 

(§@~ I View All a@ - Height: Unit: 

0.15 lm · I .. 
00 WBS .,. Descrl>tion Type ' Length: Unit: 
~0 ,. Plaster New Group Description 1.5 lm · I ~~ Riser • Plaster: Riser C01r1t 

~0 Side face • Plaster: Side face Area Thickness: Unit: 

~0 Plaster: Tread 
--···------·--··-· 0.02 lm · I Tread C01r1t 

Fig 44· Group: Plaster Fig 45: Riser Plaster Dimensions 
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b. In the Cost Data tab, set the Quantity 2 as 'Volume' (Figure 46). 

• Select the 'Riser' item and use the 'Count' tool to select all the three risers (Figure 47). 

I General I ksembly I Cost Data L_ r-.tt 

-

Cost Quanttties 
Quantity1 (Qty 1): 

!count •J 
Unit: 

~ 
Quantity 2 (Qty 2): Unit: 

!volume _ ... J lnr ~ ... J 
-==-" 

Fig 46: Quantity 2 

,-
I~ 
~ 
~ 

I~ 
~ 
~ 
~ 
~ 
0 

-- -
IWS "' OesotltiOn .. -.. New&...,IJeoal>tionPJ ·- • ._ ....... _. 

__ , 

·-·"-Roo<_2 ·-""-- .. - " 
Sdeface • Plaster. Side face 
T<ead Plaster: Tread 

•Tok..rf New&...,lleoal>tion(2) 

r,. I L-:J 

Coult I 
Coult 

/Om 

Coult 

• <l 4· 
. .d". . .. 

~ 

Fig 47: Count 

. ... 

12. Repeat the above step for the tread also. 

Tokeoff 1,1iil . 
I~ WBS .. Oos<rl>tion Type A 

I~ := .. - .. Newcm..o...._oo 
· ~ .. - ·--(3} <;ou,t 

4 . .::! .. . 

~:= Sldefaee 

·--~-
,., .. 

·i~ 
·~ 'Quit 

Tread_l Plaoter:Tread C<Ult 

~ Tread_2 Plaster: Tread C<Ult 

~ lllil!·~ .. . ~ - ... 
,p .. raked! NewC....,~(2) <l 

Fig 48: Tread 

13. Select the side face item and measure the area with the help of 'Polyline Area Takeoff' tool. 

T~ff ~ ii i 
1 ~@0 IViewAII a (.£] =· 
~ 
~ 
~ 
~ 

I~ 
~~ p 

Fig 49: Side Face 

14. Select the created 'Side face_l' object and duplicate the same (Figure 50&51). 

15. Switch on the Takeoff group display and check the results in workbook (Figure 52). 
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Q0 
.. I Oos<rl>tiOn 

-cm..~(l)jr"" .. ff 
I· Piaotet:Aiset{l) - !_[§)@@ [ViewAI '!!!' • !J!il!li !lili!!Oti(IC' . a® 

~ WBS .. DescriptiOn 

~~ yP!ootoo- New~ !leta1ption (8) 

- .. - ·--(3} 
Cut 

Copy 

Paste 

Dtltt< 
~:= 
~ .. ~-

Now Group 

Ntwhtm 
Duplicate 

~~~ ,E I~ 
,o 

Sldefoce_l 

.. Tread 

• Tli<edf 

Fig 50&51: Duplicate 

• Plooter: Side faee • .... , . . 
Plooter: Tread(:l} 

New~ Oescr1>tiOn (2) 

WBS "' I Descriptioo I Quantity 1 I Quantity 2 I 
Type Plaster _N_ew_ uroup_· _ uescnptionc.:.:.::.:..-+-:-=-:-:-+. __ _, _ 

Plaster.Riser _ . Plaster: Riser 3.000 ea _ 0.014 m1 

C<Ult Plaster.Side face • Plaster: Side face 0.540 m2 0.000 

~--
"'"" 

- Plaster.Tread • Plaster: rre-;! G:"ooo I ea 0.027 m' 
1- I ~ · - --+-

Takeoff New Group Oesa1plion 

COU'It Takeoff.BIIckv.'Oik 
1 

New It;; o;;(;rtj;iiQ;;'f0:27o 
1
m> GA04 ;> 

I Takeoff.Concrete Foun_<!ation .• Ne-.dern Oescnption ~~ lll2 ~ ~~Ill' _ 
Fig 52: Workboo k 
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3. USING AUTOMATIC TAKEOFF TOOLS 

Use automatic takeoff tools to create takeoff for objects in 3D models and 2D sheets. Automatic takeoff 

tools use the design data from the publishing application to create takeoff, rather than measuring 

drawing geometry as manual takeoff tools do. 

ill Model Takeoff Tool 

Using the Model Takeoff tool, you can use the object tree from a 3D model to create valid takeoff for 

a project. When you perform a model takeoff, QTO recognizes the objects in the model and places 

them in a group on the Takeoff palette, with a group name derived from the name of the model. The 

first time you use this tool; all items in the group have 'Undefined' as their item type. When you define 

the item types, you create valid takeoff for those items and objects, and your selections are used to 

predictively assign item types during subsequent uses of the tool. 

You can perform model takeoffs on multiple models in a project. If the project contains matching 2D 

sheets, these sheets are marked up and cross-referenced. 

Note: With DWF files published from supported AutoCAD- based and Revit-based design applications 

(version 2010 or later), you can perform a model takeoff using only a 3D model. DWF files published from 

earlier releases of these applications require the use of both a 3D model and the supporting 2D sheet set. 

illl To perform a mode l takeoff 

1. On the Documents palette, select a 3D model. 

2. On the toolbar, click Model Takeoff. 

3. Click the model on the canvas to start the takeoff. You can also perform a model takeoff by 

clicking Takeoff menu » Model to start the takeoff immediately. 

4. When a dialog prompts you that the takeoff is complete, you can select Do not display again. 

5. Click Close. 

6. Open the Takeoff palette, and view the items in the takeoff group whose name is derived from 

the model. 

Note: If you have already run a model takeoff for the selected model , a numerical suffix is added to t he 

name of the new group to prevent duplicate names. 
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HANDS-ON: ESTIMATION AND COSTI G F R A. SINGLE WALL 

Prepare a cost estimation of a single brick wall as follows . Assume that the wall has 12mm plastering on both the sides. 

• Length = 4m 

• Height 

• Thickness 

• Material Cost 

• Brick work 

• Plastering 

• Labor Cost 

• Brick work 

• Plastering 

Manual Calculation 

=3m 

= 0.3 m 

= Rs.300im3 

= Rs. 15Im2 

= Rs. 50Im3 

= Rs. 7Im2 

Quantity of Brick work = 4 x 3 x 0.3 = 3.6 m3 

Cost of Brick work = Quantity of Brick Work X (Material Cost+ Labor Cost) 

= Rs. 1,2601-

Quantity of Plastering = Length X Height X 2 

=24m2 

Cost of Plastering = Quantity of Plastering X (Material Cost + Labor Cost) 

= Rs. 5281-

Total Cost = Rs. 1,7881-

Autodesk Quantity Takeoff (using a 3D DWF from a BIM tool) 

• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name =Wall 

• Unit System = Metric 

• Currency 

• Catalog 

= Rs. 

=None 

• Import Files =Select the given file 'Wall Quantity Takeoff.dwf' (Figure 1) 

• Switch to 'Takeoff' palette and create a group called as 'Material: 

• Create two items within the group called as 'Brick' and 'Plaster' (Figure 2). 

I view All 

WBS 

... Mateiral 
Blick 
Plaster 

.,. Description 

New Group De ... 
. New Item .. . 
• New Item .. . 

Fig 1: Document Palette Fig 2: Material 
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• Double click on the 'Brick' material and set the properties as follows. 

• Type = Volume 

• Material Cost= Rs. 300/-

• Labor Cost= Rs. 50/- (Figur 

• In the same way set the properties for 'Plaster' as follows. 

• Type = Volume 

• Material Cost= Rs. 15/-

• Labor Cost= Rs. 7/-

• Create one more group 'Wall' with an item 'Standard Wall' (Figure 4). 

• In the 'Takeoff Item Properties' of the 'Standard Wall' item; 

• Set the type to 'Volume: 

• Switch to Assembly tab and Click on the'+' icon. 

• Select both the materials and add the same (F'g• "' 5). 

Cost Computation 

Material Cost: 

Takeoff 

®)@~ IVie•N All a @) 

~0 WBS "' Description 

~0 'f Mateiral New Group De ... 

~0 Brick New kern ... 

~0 Plaster New kern ... 

Type 

Volume 

Volume • Brick - New Item Description 300.00 X I Qty 1 (Volume) · I 
Labor Cost: 

sQ X IQ;y 1 (Volume) • I ~0 
'f WaH New Group De ... • Plaster- New Item Descnption 

~0 Standard WaH • New kern ... 

Fig 3: Cost Computation Fig 4: Wall 

Undefined flilil Wall • Ne·,.,. Group Description 

Fig 5: Wall Materials 

• In the 'Material Plaster' click on Quantity 1 and enter the formula as 'Area*2: And set the unit as 'm2
: 

• In the saine way enter the formula 'Volume*0.926' for the 'Material Brick' and set the unit as 'm3
' (In the 3D 

model; Wall thickness= Brick work+ Plastering) (Figure 6). 

• Save these settings as a Catalog for future reference. 

• File menu » Export » Catalog 

• Enter a name as 'Wall Quantity Takeoff' and save 

• Select the imported model in the 'Document' palette and activate 'Model Takeoff' tool. And select on the 

wall model in the canvas. Close the confirmation dialog box (Ftgure 7). 

Type: 
~· L .. x_ , 
--- ---!volume 

Takeoff Complete 

General Results 

Model: 30 View: {30} 

Count: 1 obje<:ts 

LJ Do not show this dialog again Close 

Fig 6: Assembly Fig 7· Model Takeoff 

• Switch to 'Takeoff' palette. Drag the 'New item 1' wall into 'Standard Wall' (F :51 r b). 

• In the 'Workbook' expand the wall and check the quantities. Compare the results with manual calculation 

(Figure 9). 
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- --------------------i:J.,-
Ti!lkeoff 

j(§J@0 !vi~wAII 

WBS 

, Mateir.!ll 

Brtck 

a0 
"' I Description I Type Length 

New Group De ... 

Newlem ... I ~ 
New hem ... Volume 

30VJeW: {3D} 

Walls 

Undefined 

3D View: {30} 
----. 

fx 

WBS .,.I Desaipticn I Quantity 1 I 
Wall _._ New Group Des~ 

T . WaD.Standald WaD New hem Description 3.888 · m' 

_t-Je.N ~em Description 3.600 ~-Mateiral. Brick 

Mateirai.Piaster _ New hem Descliplion -· 24.000 m' 

Fig 9: Wall Quantities 

• Right click on the column headers of the Workbook; remove 'Remarks' column and add 'Material Cost; 'Labor 

Cost' and 'Total Cost: Compare the results with manual calculation (Figure 10). 

• Open the 'Takeoff Item Properties' of the materials (Brcik and Plaster) and change the cost as follows and check 

the updated result in workbook. 

• Material Cost 

Brick work = Rs.350/m 3 

Plastering = Rs. 20/m2 

• Labor Cost 

Brick work = Rs. 60/m3 

Plastering = Rs. 10/m2 (Figure 11) 

-- .......... 
88 I 30 V-.(30) 88 I l0Voew:(30) 

- t. l. -- - - - - - - -- :,. r - --- - --
\~ ~1 ~ 1 a~• , l !:ir~ l uMe!iem~~ l ltQI~ I I \~ ~ I ~ 1 ~, l=ir~ I UM~r* lraWC<st 

'Y Will New~~ 1,44GM 34!:01 1,71!10 ? Wal th&oup~ 1,740.10 .C56:02 2.19&.12 
'Y Wti.~~\Ytl Ntwhm~Ql UU trr l .« G.CS ~i-0·1 1,788.10. 'Y WIISUncSII'dWel NewtemDescr!ptb't 3.888 rrf 1.740.10 -456.-Dl- 2.15&.12 
~-&dl: tWNkrn~ u oo rrr lOO.ro 1 .~eo.09 $/l.OO 1ta01 1,2SO.lO ~-Bndc - ltirttn\~ - J..soo rrr 350.00 1.2ED.W &0.00 21& . .o2 1.476.12 
~.Piedet New tem ~ 14:000 rrr lS;oo !&O.oo 7.co 1u oo m.oo ~.P~Mtet New tern~ 24.000 nr 20.00 4..CO.oo 10.00 240.00 m .oo 

Fig 10: Costing Fig 11: Updated Costing 

HANDS-ON: ESTINlATION AND COSTING OF A SINGLE \VALL \VITH OPENINGS 

Prepare cost estimation for the wall as shown in the following figure (units are in mm). Assume the wall thickness as 

230mm which includes 12mm plastering on both the sides. 

• Material Cost 

• Masonry= Rs.350/m 3 

• Plastering = Rs. 25/m2 

• Labor Cost 

• Masonry= Rs. 60Im3 

• Plastering= Rs. 15/m2 

-

P! v /

7 

~ 
I I " ' ~ , 

-

_l_ 

I 
I 

0 
0 g , 

-+ 1000 
·j 

7000 
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Manual Calculation 

Wall Volume 

Volume of Masonry 

Cost of Masonry 

Area of Plastering 

Cost of Plastering 

Total Cost 

= 4.071 m 3 

= 3.681 m 3 

= Rs. 1509.21/­

= 35.4 m 2 

= Rs. 1,416/-

= Rs. 2,925.21/-

Autodesk Quantity Takeoff 

• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name =Wall with Openings 

• Unit System = Metric 

• Currency = Rs. 

• Catalog =Wall Quantity Takeoff (Created in the previous hands-on) 

• Import Files = Select the given file 'Wall with Openings.dwf' 

• In the 'Select Items to Import' dialog check all the items and Import (F·g.ue 1.). 

CADD 
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• Switch to 'Takeoff' palette. Unlock the WBS structure and change the Masonry and Plaster materials costs as 

given in the problem. 

• In the 'Takeoff Properties » Assembly tab' of the Standard Wall change the 'Quantity 1' of the Material.Wall to 

'Volume'·' 0.9041: 

• Select the imported model in the 'Document' palette and activate 'Model Takeoff' tool. And select on the wall 

model in the canvas. Close the confirmation dialog box. 

• Switch to 'Takeoff' palette. Drag the 'New item 1' wall into 'Standard Wall: 

• In the 'Workbook' expand the wall and check the quantities. Compare the results with manual calculation 

(Figure 13). 

Select Items To 

rJ Material - New Group Descnption 
~.. ! .... ~Masonry - New Item Description 

, L~ Plaster- New Item Description 
B-·~Wall - New Group Description 

!.. .. ~standard Wall- New Item Description 

Fig 12: Import Items 

... 
... 

wss ~l Descripticn I Quantity 1 

Wall New G~l!P Desc:ri~tion 
-!----

WaiLStandard Wall New Item Description 4.071 ml 
---- ----- ---+-

MateiraLBrick New Item Description 3.681 ml 

Mateirai.Piaster New Item Description 35.400 m2 

Fig 13: Wall Quantities 

• Right click on the column headers of the Workbook; remove 'Remarks' column and add 'Material Cost; 'Labor 

Cost' and 'Total Cost: Compare the results with manual calculation. 

W8S 

Wall 
Waii.Standord Wall -·-- . 
Ml!!eiroLBrick 

DescriptiCJ1 

New_ Group Descril>lion 
Newlem~on 

-~ kern Des~ion 
New ~em Des~ion 

-f--
4.071 m' --.-
3.681 m' 350.00 

35.400 m' 25.00 

Fig 14: Costing 

1.288.21 
885.00 

60.00 
15.00 

751 .84 
220.84 
531 .00 

2.925.04 
2.925.04 
1.509.04 
1.416.00 

• In the 'Takeoff' palette, change the 'Door' and 'Window' type to 'Count: As well as add the 'Cost' information 

also (Figure 15). 

• If required, change the group name and check the 'Workbook' for the updates (Figure 16). 



CADD" 
CENTRE Chapter 3 

,. NewGmup_2 
,. New Group 

Doors (1) 

M_Single-fluah (1) 

I ' ~~lv ... 
NeW lem_1 M_Single·Flush [1365 ... E~ 

1' New Gmup_3 Welb Unoar 
• New Gmup Basic Wal Aroa 

New lem Genertc • 230 nm Volume 
1' Wall New Group Desalption (1 ) dii.W 

Fig 15: Door Type 

iWJ Search Takeoff Tool 

wss + 1 Description 1 Quantity 1 1 ,._,; .. ~. j T~~ · 1 Unitc~i Total! Total Cost 

1' wan _._ New ~-~ion -;-~!~P· ·· _ ' _1_,75 ... I 1S,925.04 
1' Waii.Ooors &Wndows 3D\iew:{30} , 16.00... ' 1,00... 17,000.00 

.,.. Waii.Ooors & Windows.Doors-_, Doors - t---+- · -~~=n¥:00 -~ 
--+- : I .~:·~ I .,.. Waii.Doors & Wndows.Wndows Windows 6.000 .... · 500.00 6.500.00 

- I ---1 ~ - +· --
1' W~!I.:._S!_~Wan _ ~ ~ . l!l~w~em~~~ 4071 ~m~ . 2,173. ... ~~~ 2.S25.04 

Matei!ai.Brick New lem Description 3.681 m' 350.00 1,288.. .. 60.00 220.84 1,50S.04 
Matei!al.Plaster - N;;w lem Description- 35.400 I m' 25.00 885.00 15.00 531 .00 1.416.00 

- - -- ' ' - --- -·- ~ ::":."":: ±"::-:- =:- ::---:::::::·:-:-::·-

Fig 16: Cost 

Using the Search Takeoff tool, you can create takeoff using design data as search criteria. Object dimensions, family 

names, types, and other property data make it easy to quantify similar objects. For example, you can create takeoff objects 

for all rooms in a project that have a specific Room Type property. Search Takeoff is performed on the entire project. 

When you select a piece of geometry on a sheet or model using the Search Takeoff tool, its properties are displayed 

in the Search dialog. You then select one or more properties to use as search criteria, and the Search Takeoff function 

queries the project and records all matching objects both on the Takeoff palette and in the Workbook. Select an item 

on the Takeoff palette prior to starting a search takeoff to have the results added to that item and named based on the 

item's family or style. 

Note: In some cases, design objects are m iss in g key identifiers (IDs) in the DWF files that are publ ished from des ign 

applicatio ns. The Search Takeoff tool ca nnot create takeoff for design items that a re missing IDs. 

iD To Perform a Search Takeoff 

1. On the Documents palette, select a DWF sheet or model. Search Takeoff "X" 
I 

2. To add the takeoff objects to a group or item, select the group or 

item on the Takeoff palette. If no group or item is selected, the 

objects will be added to the root of the Takeoff palette. 

- -~ I 

3. On the toolbar, click Search Takeoff. 

4- On the canvas, select the object you want to search for in the 

project. You can also perform a search takeoff by clicking Takeoff 

menu » Search, after you select an object on the canvas (Figure 17). 

5. In the Search Takeoff dialog; 

44 

a. For Name, the item name from the model is displayed. If you 

selected an item on the Takeoff palette before clicking Search 

Takeoff, the name cannot be modified. If you selected a group 

or no entity on the Takeoff palette, you may modify the name. 

b. For Item Type, if you selected an item on the Takeoff palette 

before clicking Search Takeoff, the Item Type value cannot be 

modified. If you selected a group or no entity on the Takeoff 

palette, select an item type for this takeoff, or select Undefined 

if you want to specify the item type later. 

c. For Destination, the default value shows the location where 

the takeoff objects will be created. This value is either the path 

of the item or group you selected, or the root of the Takeoff 

\<IBS: New l em 

Description: Generic - 200nm 

Item Type: !Linear ? J 

Destination: ' I Browse I 
Select the property values to use as search criteria: 

Property "'' v~ 
8 Analytical Properties 

D Absorptanc• f o.1 

0 Heat Tronsre- CO<!f .• . ;...~1-.6-59_4_W_/_(m-,--K)----I 

D Roughness 11 I = II 
0 Thermal mass 138.69 kJ,1( 

0 Thermal Resistance ... j-~0-.6-0-26-(m-,--K)-{W-----

8 Basic Wal [176829] 

0Guid 

01d 

8 Constraints 

r 2flo5ac8·5073-'16f6-93a9-6 ... 

1176829 

D Base Constroint r Level 1 

l6::m
0

~ i-~6-----
0 repoffset o 

o_~ectedHeight r-13000-:--_ ---~~=-~--8 
( Search] I Cane~ I 

Fig 17: Search Takeoff Tool 

• 
• 
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~ I 
Destination: 8edrical Fbdt.res\ 

Sele<:t the property values to use as search criteria: 

8 Otllet' 

E Search Toi<eoff 

l:ol 0 
.tJ(gj 

=· I 
- ,I 

WBS + ~tion T)ll<! Length Cl EIQd<<oi 

.. Bedricall'i>chno New'""""~ (i) 
• •' •• , • II I I . - .• I 

Ceing Ugl<_l . M_Ceing Ugl<- U1... ~---• ·~•-~-• E"""'* 

Ceing Ugl<_2 • M_Ceing light - U1 .. . 

Ceing Ught_3 • M_Ceing Ugl< - U1 .. . 

Ceing light_4 . M_Ceing light· U1 .. . 
~ Elocti~l 

Ceing light_5 • M_Ceing light - U1 .. . 
T-tv ... !vai.Je G[' 

1
1 ~Fom;!y""""' j!'!3§ ·· .511.rlfiMI 

0Hostld lPlain 
Ceing light_6 • M_Ceing light- U1 .. . 

Ceing Ugh_7 • M_Ceing Ugh- U1 .. . 

C<ult Undefiled 
C<ult Undefiled 
C<ult Undefiled 
C<ult Undefiled 
C<ult Undefiled 
C<ult Undemed 

~ E~ 
[: _ I' I L__..JI 

Fig 22: Search Takeoff Fig 2_3: Search Takeoff 

• Repeat the step numbers 4 and 5 to create the wall lamp schedule as follows (Figure 24). 

• Expand and check the takeoff. As a total it has 13 Electrical Fixtures (Figure 25). 

• Open the 'Ceiling Light-Takeoff Item Properties' and add the following cost values. 

• Material Cost = Rs. 1000/unit 

• Labor Cost= Rs. 100/unit (Figure 26) 

{::l[Qj 

~@0 ~ j 
Takeoff 

a0 
~ WBS + I Description 

~ I~ ~UE 
~ I~ ~ Ceitng liglt !] ~ Ceiling Ught_1 
~ Ceiling Ught_2 
~ Ceiling Ught_3 
~ Ceiling Ught_4 

~ Ceiling l.ight_5 
~ Ceiling Ught_6 

~ Ceiling Ught_7 

~ ~WaUlamp 

I~ Wa!llamp_1 
~ WaHlamp_2 

1~ WaH lamp_3 

=rtT'FfJWf''l 
• 300 x1200 mm (7) Count 
• M_Ceiting Ugh! -Lin ... Count 

• M_Ceiling Ugh! -Lin ... Count 
• M_Ceiling Ugh! -Lin ... Count 
• M_Cetling Ugh! -Lin ... Count 
• M_Ceiling Ugh! -Lin ... Count 
• M_Ceiting Ugh! -Lin ... Count 

• M_Ceiting Ugh! -Lin ... Count 

. 100W (6) Count 
• M_WaU lamp- B<ac ... Count 

• M_Wan lamp- Brae ... Count 
• M_WaU lamp - 8Jac .. Count 

Description: 300x1200mm 

Type: [eo.n 

Cost Quant~ies 

Quantity 1 (Qty 1): Unit: 

[count ~J [ea 
Quanti!'; 2 (Qty 2): Unit: 

[ ~ J [ 
Tl!ne 
Time: 

- -[3 x [ 

Cost Computation 

Material Cost: 

~ ] 

~ I 

~ J 

:J 

~ WaUlamp_4 • M_WaU lamp- B<ac ... Count 1.000.00 X [Qty 1 {CotrtH 
~ WaUlamp_5 • M_WaH lamp - Brae ... Count Labor Cost 
~ Wa!!lamp_6 • M_WaH lamp- B<ac ... Count 100.00 X I Qty 1 {Cotrt) ~ I 

Fig 24: Search Takeoff Fig 25: Takeoff Fig 26: Cost data 

• In the same way add the cost data for the wall lamp as follows. 

• Material Cost= Rs. 1450/unit 

• Labor Cost= Rs. 70/unit 

• Customize the workbook columns to get the following report (Figure 27). 

!.801 ElectricaiFodures 

b [ 
o--

J I I Q . 1 I Material Cost I · i Total Cost I WBS Description 
Labor Cost 

uan!Jty I . Unit cost I Toil! I I Unit cost Total 

lj -!_=----~~:~==CeflingU~ _ 1:::~:u;: I 15.700.00 1.120.00 1 16.820.00 
7.000 1 ea I 1.000.00 7.ooo.oo I 100.00 700.00 1 7,700.00 

1 1 Electlical fiX!ures.Wal! Lamp . 100W 6.000 ea i 1.450.00 8.700.00 iO.OO 420.oo I 9,120.00 

Fig 27: Workbook 

• Change the Material and Labor cost and check the report. 
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~Single-Click Auto Takeoff Too l 

Using the Single-Click Auto Takeoff tool, you can create a takeoff measurement with a single click on a piece of geometry 

in a 3D model or 2D sheet. By default, the takeoff data you create with the Single-Click Auto Takeoff tool is grouped 

according to the family (or style) defined in the object's properties. However, on the Contextual Tools palette, you have 

the option of grouping the takeoff data by selection instead. When you group by selection, the takeoff is added to the 

group or item that is selected on the Takeoff palette. If you add the takeoff to an item, the object(s) display below the 

item, using the name from the object properties. If you add the takeoff to a group, an Auto item is created within the 

group, and the object(s) are added to that item. The grouping option you select becomes the default selection. 

iBI] To Perform a Single-Click Auto Takeoff 

1. 

2. 

3. 

4. 

s. 
6. 

7. 

If the Contextual Tools palette is not displayed, click Window menu » Contextual Tools. This palette contains 

options for grouping the takeoff data you create with the Single-Click Auto Takeoff tool. 

On the Documents palette, select a DWF sheet or model. 

On the toolbar, click Single- Click Auto Takeoff. 

On the Contextual Tools palette, select one of the grouping options. 

a. Family: The takeoff data will be added to the group that matches the family (or style) of the object. 

b. Selection: The takeoff data will be added to the group that is currently selected on the Takeoff palette. 

If you are grouping by Selection, on the Takeoff palette, select the corresponding takeoff item. 

On the canvas, select the object you want to measure. The geometry is marked up on the canvas, and the takeoff 

data is added to the Takeoff palette, based on your grouping option. 

On the Takeoff palette, if the Type value for the object is Undefined, select the appropriate value for the item 

that contains the object. Type refers to the manner in which takeoff is calculated for that item. 

Note: The first time you use this tool to group by family; all items in the group have 'Undefined' as their item type. When 

you define the item types, you create valid takeoff for those items and objects, and your selections are used to predictively 

assign item types during subsequent uses of the tool. You can specify whether last-used item types are used for subsequent 

automatic takeoffs. 

HANDS-ON 

• Create a new project in Autodesk Quantity Takeoff as follows. 

• Name 

• Unit System 

• Currency 

• Catalog 

• Import Files 

= Residential Building 

=Imperial 

= Rs. 

=None 

= Select the given file 'Residential Building.dwf' 
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• Activate the 'Single Click Auto Takeoff' tool with 'Family' as the group option. 

I® ~ ~1 ·I 
I Group by: @ Fam~y 0 Selection 

Fig 29: Single Click Auto Takeoff Tool 

• Select the Parapet Walls of the modeL 

Undefined 

Undefined 

Undefined Unde· 

Undefined Unde· 

Undefined Unde· 

Undefined Unde· 

Undefined Unde· 

Undefined Unde· 

Fig 30, Takeoff 

• In the 'Takeoff' palette Change the item properties as follows. 

• WBS = Partition Wall 

• Type = Volume 

• In the 'Takeoff Item Properties' enter the Cost values. 

Cost Computation 

Material Cost: 

~ .ooo.oo· x [Qtv 1(Volume) ... ] 

Labor Cost: 

250.00 X jaty 1 (Volume) • ] 

~.Nvo.ntr.vo-tnr r~t· 

Fig 31: Cost 

• Customize the 'Workbook' to get the following output. 

WBS "' 
Partition Wall 

Descriptia1 

. 4.5"wall 
I 

Quantity 1 

• Repeat the above steps for the main walls, Slab, Windows and Ventilators. 

Fig 33: Main and Partition Walls 

Chapter 3 

Total Cost 

1.79.630.89 
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\IIJBS +I Descriptim Quantity 1 I Material Cost I Labor Cost 
Total Cost I I Unit cost Total I Unit cost Total 

Main Wall . 9"Wall 1.231 .652 fP 1.000.00 12.31.652.23 250.00 3.07.913.06 15.39.565.29 
·-t= 

143.705 lfP 1.43.704.72 1 
---

Partition Wall 1. 4.5"wall 1.000.00 250.00 35.926.18 1.79.630.89 
t . -

Fig 34: Main and Partition Walls 

.?; 

d @ -

"' Desaiption Type 

• Aoor Slab -6" ... Volume 
• 9" Waft (14) Volume 
• 4.5" waH (8) Volume 
• Roof Slab -6" ... Volume 

2' X 2' (2) Count 
. 5' X4'{3) Count 
. 4' X4' (4) Count 

WBS +I Descriptioo I Quantity 1 
Material Cost Labor Cost l Total Cost I Unit cost Total Unitcost I Total 

RoorSiab 1• Roor Slab -6" I 650.695 ftl 600.00 3.90.416.99 ---~~:~ i 
1.30.139.00 I 5.20.555.99 

I 
Main Wall . 9"Wall I 1.231 .652 ft3 1.000.00 12.31.652.23 1 3.07.913.06 15.39.565.29 

------ -·-~ .4.5"wall Partition Wall 143.705 ft3 250.00 35.926.18 1.79.63089 
-

1.62.673.75 5.55.090.74 650.695 I ft3 Roof Slab , • Roof Slab - 6" 
Ventijators 2.000 ea 300.00 2.1 00.00 
Wtndow ~-- 3.000 ea 600.00 8.100.00 
Window 1 I 4.000 ea 800.00 8.800.00 

Fig 35: Slab, Window, Ventila tor 
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4 VIEWING AND VALIDATING TAKEOFF DATA 

After you create takeoff data using automatic or manual takeoff tools, it is important to review and 

validate the data to ensure the quality of the information. 

When you create takeoff data in QTO, takeoff markup is displayed on the canvas, each measurement is 

recorded as an object on the Takeoff palette, and quantity and cost data is aggregated in the Workbook. 

All of this data is linked in a 3-way cross-reference. Therefore, when you select takeoff geometry on the 

canvas, the corresponding object is selected both on the Takeoff palette and in the Workbook. Similarly, 

when you select an object on the Takeoff palette or in the Workbook, the takeoff geometry is selected on 

the canvas. This 3-way visual cross-referencing of objects-on the canvas, at the project level (Takeoff 

palette), and at the sheet or project level (Workbook)-is designed to help you validate takeoff data. 

Only items that have a measurable value display in the Workbook. Items are measurable when they have 

both a defined Type value (either Linear, Area, Volume, or Count) and a defined property for at least 

one dimension. 

Methods to validate takeoff data 
• Verify that when you select an object on the Takeoff palette, the same object is selected in the 

Workbook and on the canvas. 

• Right-dick the object on the Takeoff palette, click Views, and click a view drawing on the list that 

displays. QTO zooms in to that object on the canvas. 

• Right-dick the object on the canvas, and click Locate Object. The corresponding object is selected 

on the Takeoff palette. 

• Use the Search feature to locate all occurrences of a word or phrase, and select a specific search 

result to view the related takeoff data. 

m! Compare 

Use the Compare feature to compare a 2D DWF sheet (base sheet) from your current takeoff project with 

another 2D DWF sheet (target sheet), either in the same project or in an external location. The Compare 

feature detects any differences between the two sheets and displays the results in two ways: As numeric 

values in the Additions and Deletions columns on the Documents palette, and as a color-coded visual 

representation of additions and deletions on the canvas. This visual representation, called the comparison 

result, is saved on the Documents palette as a subdocument of the base sheet. 

50 
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Sheet comparisons are an essential tool for managing sheet versions. When you receive updated sheets fro m a 

designer after you have completed takeoff on the original sheets, use the Compare feature to see the extent of the sheet 

modifications. Based on the comparison results, you can determine whether to modify the takeoff on the original sheets 

or, if the changes are extensive, whether it is better to abandon the original takeoff and create takeoff for the updated 

sheets. Alternatively, you can run the sheet comparison, mark up the updated sheets, and then send the comparison 

results and markups to the designer. 

Note: Comparisons run faster when your target sheet is in an external location rather than imported into the current project. 

General ly, it is advantageous to evaluate the percentage of change on an updated sheet before importing it into a project. 

Note: Although models are ava ilabl e for se lection , the Compare feature ca nn ot be run on models. Attempti ng to do so 

resu lts in an error message. 

To Compare Sheets 

• On the Documents palette, select a 2D DWF sheet to use as the basis for your comparison (base sheet). 

• If takeoff graphics are displayed on the canvas, on the Takeoff palette, click the Show all /Hide all check box, 

located to the left of the column headers. This check box controls the visibility of all takeoff graphics on the 

canvas. Turning off takeoff graphics improves the view of the color-coded additions and deletions that are 

displayed in the comparison results. 

• Click Compare on the palette toolbar. You can also click Document menu » Compare, or right-click the 

document and click Compare. 

• In the Compare dialog, under Select File, do one of the following: 

• Select Current Project if you want to compare the base sheet with a target sheet in the same (current) project. 

• Select External File if you want to compare the base sheet with a target sheet in another project or in a 

non-project folder on your computer or network. 

• Based on the location of the target sheet, do one of the following: 

• If you selected Current Project, select a 2D DWF sheet from those displayed in the Compare dialog. 

• If you selected External File, click Browse, navigate to and select a 2D DWF sheet, and then click Open. 

When you select a target sheet, the title bar of the Compare dialog is updated with the name of the sheet. 

• To modify the on-canvas display of additions (green, by default) and deletions (red, by default), click Options, 

and modify the default values in the Compare Options dialog as needed: 

• When you click a default color, the Color dialog opens. Select a different standard color or create a custom 

color, and click OK. 

• The Opacity percentage controls the depth of color applied to the additions and deletions on the canvas. 

The higher the opacity percentage, the darker the color. 

• In the Compare dialog, click OK. 

Review the Comparison Results 

• When differences are detected, markups are visible on the canvas. Additions (green, by default) identify any 

graphics in the target sheet that are not in the base sheet. Deletions (red, by default) identify any graphics in 

the base sheet that are not in the target sheet. 

• To toggle additions off and on, click Document menu » Display » Additions. 

• To toggle deletions off and on, click Document menu » Display » Deletions. 

• On the Documents palette, scroll to the Additions and Deletions columns to see the number of additions and 

deletions found by the comparison operation. 

5 
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• If no differences are found by the comparison operation, the Comparison Result message box reports this result, 

and no comparison document is added to the Documents palette. 

• If the comparison cannot be performed (for example, if you have selected a model for comparison), the 

Comparison Result message box displays. Review the message, and click OK. 

The comparison result is saved on the Documents palette as a subdocument of the base sheet, using a VS Target 

Project: Target Sheet naming convention. Rename the comparison result if you want, using a descriptive name to 

maintain the usefulness of the comparison as a reference document. 

;HANDS-ON 

52 

• Create a new project as follows. 

• Name: Compare 

• Unit System: Imperial 

• Currency: Rs. 

• Catalog: None 

• Import Files: Base Plan.DWF 

>ocum~n1s {1) 4\ IQJ 
@ @)@) @ 

Name 
=~ I 

"' I Takeoff j L~ j L~1 

Bas~ Plan 

~ ~-,;_~~~.it. 

• Document menu » Compare 

lS~_ 

0 0 lS • 

Fig 1 Base Plan 

• Select 'External File' option and browse to the given 'Target Plan.DWF' (F gure 2) 

• Set the colors for the display by activation 'Options' ( - {J • .J ). 

0 Current Project 

@ External File 

D:\Co<new_,\QTO\Supporting Files\ Torget Plan I Browse... I = • 
Select sheet to compare : 

EJ 
(1) floor Plan: level1 

Options ... OK ) [ Cancel 

.. Compare 

Color 

Additions: 

Deletions: 

Opacity: 
10,. 

~ I Cancel 

F1g '1 Compare Options 

any 

Any-
and 
res: 

Wh 
ga 
sin~ 
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• Select 'OK' in the co e :eports ( 

• Use the 'Documen ange the colour for the additions and deletions display and toggle 

the same ( ). 

Documents ( 1) 

@@)@) (81 

.,. I Tala!off !.egen:l I LastMocified I Additions-~ Deletions I 
0 

Fig 4 Document Pa lette 

~ Reports 

19.00·20 13 11:33:00 

19-()9·2013 11:37:45 16 23 

Fig 5: Additions 

Report lt{lndow t!elp 

Rotatt!:Right Ctri+R 

Rot•t• Left Ctri•L 

Rotatelso• 

~ompare ... 

QlSplay • 

Units and ~cale ... 

Document E,roperties ... 

Fig 6: Display 

../ Additions 

.; Deletions 

Options ... 

Create reports to see summarized or detailed takeoff data for your entire project or a selected portion of it. QTO 

provides the following report types that you customize by making selections in the Report dialog: 

• Summary: A cost report that can include quantities and cost information for each takeoff group that contains 

takeoff data. 

• Group (Items Only): A detail report that can include quantity and cost information for each item in your project. 

• Group (Items and Objects}: A detail report that can include quantity and cost information, object properties 

and dimensions, and sheet location for each item and object in your project. 

• Material (Items Only): A bill of materials that can include quantities and cost information for each item in 

your project. . 

• Material (Items and Objects): A bill of materials that can include quantity and cost information, object 

properties and dimensions, and sheet location for each item and object in your project. 

To generate a report, specify the report type, content, and layout elements that suit your needs. The report is displayed 

on the canvas and added to the Documents palette for future reference. In addition, the report name is added to the 

Recent Reports list on the Report menu; where you can select it to generate future reports, using the previously saved 

report settings. The Recent Reports list displays the last 10 reports generated from the current project. 

When you select a report from the Recent Reports list, QTO uses the predefined settings as a report template, 

gathering the specified takeoff data from the current project and generating a new report. Predefined reports provide 

single-click reporting. Each time you run a report from the Recent Reports list, the newly generated report includes 

any modifications you have made to the takeoff data since the report was last run. 

Any reports you generate are displayed on the Documents palette as documents, which can be viewed, printed, 

and exported. Report documents and predefined reports (that is, Recent Report menu items) are saved within their 

respective projects. 

W hen you select a report from the Recent Reports list, QTO uses the predefined settings as a report template, 

gathering the specified takeoff data from the current project and generating a new report. Predefined reports provide 

single-click reporting. 

Note: If you publ ish a takeoff project to a DWF file , reports are not included. 
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~ Reports Dialog 

General Tab 

• Name: By default, the project name is used as the report name. Give 

reports descriptive names based on report type and content which helps 

to easily distinguish among various reports listed on the Documents 

palette and the Recent Reports menu. 

• Report Type: The Report Type value controls the content that can be 

specified for the report. Material reports can include quantity and cost 

information, object properties and dimensions, and sheet location for 

each item and object in your project. The actual content of the report is 

determined by your selections on the General tab and Columns tab. For 

example, to generate a report that shows only cost by item (excluding 

object data and quantities), you would select the Material (Items Only) 

report type and specify only cost-related columns. 

• Level of Hierarchy: Takeoff entities are the takeoff groups and items 

that are defined on the Takeoff palette for the current project. The Level 

of Hierarchy value controls how many levels of groups are displayed in 

Chapter 4 

.. . 
--· 

~----

Genetal L eouoos I layod J Header&Footerj 1.' 

Name: 

Colrt T akeolf 

Report Type: 

ls..-y ---- - · I 
Takeoff &tty 
Level of Hierarchy: 

IAI · I 
Available Selected 

~ JOOery Oetais 

0 · Door4'X7 10 01-Door 3' X 7 
02 -Door 2'6'X 7 

V -VentiotJ>r2' X 2' 8J 
W · Wndow S X4' 

Wl - Wndow 4'X4' I I 

I Create Report II Cancel I 
Fig 7: Reports-General tab 

the entities tree that makes up the Available list. For example, if you specify 1, the entities tree includes only 

top-level groups. If you specify 0, the entities tree includes no groups, only items. 

Column Tab 
The report type you selected determines the columns that are available. The Description column is included for all 

report types. You can rearrange columns using the GJ and G buttons (Figure 8). 

Layout Tab 

The settings you specify on the Layout tab determine how the report will look on the screen or on paper. The 'Include 

page breaks after each group' helps you to split the takeoff table based on the groups. If you want to show the table 

border lines, use the 'Show Grid' option. You can control the report width with the help of Orientations (Figure 9). 

Header & Footer 

On the Header & Footer tab, you can select predefined information, such as page numbers, your company name, the 

date, and the author. You may also specify a logo or other graphic image file to include in the header or footer (Figure 10). 

~ - ~--

W'BS 

E~tCost [8 1 Labor Cost 

~teN.! Cost 
~~tyl . Q ~tity2 

~trattcrCos 

GJ ! -,.......," _..., 
G Locallon 

Remorioo 
'9 StandardOimenslions 

I - G . . 
~I • IITL 

" Cr~t~ Report 11 
Fig 8: Reports-Column Tab 
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---- -

Options 

EJ Include page breaks after each group 

[) Number Pages 

O ShowGrid 

Orientation 

0 Landscape 

@ Portrait 

Create Report j ( 

::_ X 

Fig 9: Reports-Layout Tab 

1 X 

Header: 

I (None> 

(None) 

Footer: 

(None) 

Create Report II Cancel 

Fig 10: Reports-Header & Footer Tab 
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HANDS-ON: CREATING CUSTOM REPORTS 

• Open the saved project 'Residential Building.ato: 

• Report Menu » Custom Reports ( ) 

• In the 'General' Tab of the Reports dialog set the following; 

• Name= Model Report 

• Report Type = Material (Items Only) 

• Level of Hierarchy = All 

• In the Available list, select all items and move to the Selected list (Figure 12). 

:Window .!::ielp 

Recent Reports ~ 

£;ustom Report ... ~ 

Fig 11: Report Menu 

Name: 

Model Report 

Report Type: 

I Material (loms Only) 

Takeoff Entity 

Level of Hierarchy: 

!AI 
Available Selected 

~Slab .fi;r SlabB"] 
Main Wall • 9" Wall 

r:::l Partition WaS - 4. 5" w = I 
U Roof Slab ·Roof Slab ' 

[;] Ventilators • t X :t 
Window I • 4' x, 4' EJI 

EJ'I --=-"-----.1 0 0~~ 

Creote Report II Cancel 

Fig 12: Reports-General tab 

• In the 'Columns' tab' move Description, Quantity 1, Material Cost and Labor Cost from Available list to Selected 

List. Use the GJ and EJ button to rearrange the columns (Figure 13). 

• In the 'Layout' tab; 

• Select 'Show Grid' under Options 

• Select 'Landscape' under Orientation (Figure 14) 

• In the Header & Footer tab set the header as shown in the following image (Figure 15). 

' . . -·------

Header: 

0 Include page breaks after each group I 18-09-2013,Residentail Building,Page 1 of? •J 
18-09-2013.Residentail Building.Page 1 of ? 

Equipment Cost ~ ·;.ss 
0 Number Pages 

Quantity 2 Description 
(i] Show Grid 

Remarks 

I 
Quantity 1 

1 Subcontractor Cost Material Cost Orientation 
Time I Labor Cost @ Landscape i 

I 0 Portrait 
I 
I 

Create Report II Cancel Create Report II Cancel 

Footer: 

! <None) 

(None) 

Create Report I J Cancel 

Fig 13: Reports-Columns tab Fig 14: Reports-Layout tab Fig 15: Reports- Header & Footer ta 
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• Create the Report. 

ls.o!~-37~3 ModeiRepat "-1d1 

....... (henosOI+) 

'MIS r a.-oiL< 1 .__Cos t..oborCca T-'Cca 

lNCO. T-'CO. lNCos T-'Caot 

~ Rs.2.813,MZ.!I2 

FloorS lab Floor Slab - 6" 650.695 If 600.00 390.416.99 200.00 130.139.00 520 .555.99 

Ma mWol 9" W38 1,231.652 If 1.000.00 1.231 .65223 250.00 307.913.06 1.539.56529 

Panition 'Nol 4.5" wol 143.705 If 1.000.00 143.704.72 250.00 35.926.18 179.630.89 

Roof Slob RoofSiob - 0' 650.695 If 600.00 390.416.99 250.00 162.673.75 555.090.74 

Ventila'DS 2'X2' 2.000 •• 900.00 1,800.00 150.00 300.00 2.100.00 

W..dtm 5'X 4' 3.000 •• 2.500.00 7.500.00 200.00 600.00 8.100.00 

Wondtm 1 4'X 4' 4.000 .. 2.000.00 8,000.00 200.00 800.00 8.800.00 

T-'Cca Ro2..813.114ZSZ 

Fig 16: Report 

Note: The report is added to the Documents palette and displayed on the canvas. 

~ Exporting . Takeoff Data 

There are several methods for exporting QTO data: from the Workbook, as a catalog, or from a report. When you export 

data, you transfer it from QTO to another format, such as XML (a format widely supported by applications such as 

Microsoft Excel and Microsoft Word), TXT, or Comma Separated Variable (CSV) format, which is a text file. Although 

exporting can be used as a secondary reporting method, it is primarily used to transfer data to another application. 

To Export Workbook data 

1. Open a Sheet which contains the takeoff data . 

2. Click File menu» Export » Quantities (Figure 17). 

3. In the Export Quantity Options dialog select the suitable options (Figure 18). 

56 

~port • 

frint • 
~WI- 1\.11.-.......t:A 

Fig 17: Export » Quantities 

&port Quantity ·~·- X - .. 

Sheds 

@ Current Sheet Only 

() All Sheets 

Tokd 

Select llti• dleck box to include •II items 
current hidden on the T•keoff f'lllelle. 

Export Hidden Tokeoff 

~I Cancel 

Fig 18: Export Quantity 

• The 'All Sheets' option exports takeoff data from all sheets in the project where the 'Current Sheet Only' 

option exports takeoff data from the current sheet. 

• Select Export Hidden Takeoff to include data from takeoff groups, items, and objects that are currently hidden. 

B 

5 

To E 

1 
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To EJ 

1. 

2 . 

3. 

4. 
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4. In the Export Quantities dialog; 

• Desktop 

Downloads 

~ Recent Places 

Libraries 

~ Documents 
Jt Music 

~ Pictures 

8 Videos 

;II Computer 

File name: Residentail Building.xml 

Save as type: I XML Spreadsheet r .xml) 

• Hide Folders 

No items match your search. 

Fig 19: Exports Quantities 

• Navigate to the desired export location. 

• For File name, enter a descriptive name. 
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Save I I Cancel 

• For Save as type, select either XML Spreadsheet (*.xrnl) or GAEB Data Exchange XML v3.0 (*.x81). 

• Click Save. · 

s. Open the export file to view the takeoff data. 

To Export a takeoff catalog 
1. Click File menu » Export » Catalog, or click Takeoff palette menu » Save as Catalog. 

2. In the Save as Catalog dialog: 

a. Navigate to the desired expordocation. 

b. For File name, enter a descriptive name. 

c . For Save as type, select either Takeoff Catalog (*.att), CSV (Comma delimited) (*.csv), or Tab Separated 

Variable (*.txt) . 

d. Click Save. 

To Export report data 
1. At the top of the report preview, click Export (Figure 20). 

2. In the Export Report dialog: 

a. Navigate to the desired export location. 

b. For File name, enter a descriptive name. 

c. For Save as type, select either Crystal Reports (*.rpt), Adobe Acrobat 

(*.pdf), Microsoft Excel (*.xls), Microsoft Excel Data Only (*.xis), 

Microsoft Word (*.doc), or Rich Text Format (*.rtf) . 

d . Click Save. 

3. In the Export Report message box, click OK. 

4. Open the export file to view the data. 

Fig 20: Export Report 
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~ Publishing a Project to a DWF File 

When you publish a QTO project to a DWF file, users of Autodesk Design Review and DWF Viewer can access your 

takeoff data. 

To Publish to DWF 
1. Click File menu » Publish to DWF. 

2. In the Publish to DWF dialog: 

a. For Save in, specify a location for the DWF file . 

b. Specify a file name. 

c. Click Save. 

The publishing process happens one sheet at a time, with a progress indicator reporting the status by sheet. After all 

sheets have been published, the DWF file is available in the location you specified. 

r&QJE.C_T.;_CR.EATE THE. ESTIMATION AND C_O_STIN_G_EO_R THE 

GIVEN 3D DWF CREATED FROM BIM SOFTWARE. 

1. Create a new project as follows . 

a. Name: BIM Project 

b. Unit System: Imperial 

c. Currency: Rs. 

d. Catalog: None 

e. Import Files: BIM Project.DWF 

Takeoff J,1 1Ql 
®)@~ [View All a@ 
DO WBS + Description Type ~~~ 

I 
I 

I 

..... - - -- --- -- --~ ~ 
ll: BIM Project 

2. Select the 'Model Takeoff' tool and pick the model in the canvas. 

3. Close the Model Takeoff dialog. 

Model Takeoff 

T akeofl Complete 

Results 

Model: 30 View: {30) 

Count 134 objects 

[] Do not show this dialog again I Close 

Fig 22: Model Takeoff 
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4. Expand the groups in the 'Takeoff' palette and check the extracted items. 

Takeoff 

~@® jview AII 

'f New Group Wondows (9) 

'f New Group M_louvers with T ri ... 

'f New L 8 2'X2'(2) C01.111t 

New ... 8 M_Louver.; with. .. Count 

New ... • M_louver.; with .. . Count 
11> New Gro ... M_ Casement Dbl wi ... 

11> New Group _2 Doors (8) 

11> New Group _3 Aoors (2) 
11> New Group_ 4 Railings (2) 

.,. New Group_5 Stairs (1) 

11> New Group _6 Top Rails (2) 

• 1-\ew \:loup_7 'l'l a~s ~\Ill) 

Fig 2]: Takeoff Palette 

S. Rename the Groups, Sub-groups and items as follows . Wherever required duplicate (or) delete the g 

T Wndows & Ventilators Windows (9) Y Doors Doors (8) 
T Wndows M_Casement Obi Wi .. . • 03 . 2.5' X 7(4) Count 

T W1 . 4' X4'(4) Count 
03-1 • M_Single-Rush ... Count WH • M_Casement D ... Count 

W1-2 • M_Casement D ... Count 03-2 • M_Single·Aush ... Count 

W1-3 • M_Casemert D ... Count 03-3 • M_Single-Rush ... Count 
W1-4 • M_Casemert D ... Count 03-4 • M_Single-Rush ... Count 

T W . 5' X4' (3) Count yD2 . 3' X7 (2) Count 
W-1 • M_Casement D ... Count 02·1 M_Single-Rush ... Count 
W·2 • M_Casement D ... COIXIt 

02·2 • M_Single-Rush ... Count W-3 • M_Casement D ... Count 
T Ventilators M_Louvers with Tri ... yO 4' X 7(1) Count 

TV . 2'X2' (2) Count D M_Single-Rush ... Count 
V-1 • M_Louvers with ... Count • 01 • Door (1) Count 
V-2 • M_Louvers With ... Count 01 • M_Oouble-Glas ... Count 

Fig 24: Renamed Wiridows Group Fig 25: Renamed Doors Groups 

• Railing Railings (4) 

'f Railing . 1100nm (2) C01.111t 

Rear Railing • Railing [186594] Cooot 

Front Railing • Railing [188451] Count 
'f Hand Rail Rectangular · 5... Count 

Rear Back Rail Top Rail Type [ ... ·Count-

• Slab Aoors (2) 

• Aoor Slab Aoor Slab • 6" (1) Volume 
Aoor Slab Aoor [185474] Volume 

T Roof Slab • Roof Slab • 6" (1) Volume 

y Staircase Stair (1) 

y Staircase • 1 OOnm max rise... Volume 

Roof Slab • Aoor [185975] Volume Front Hand Raa • Top Rail Type[ ... Count Staircase • Stair [188354) Volume 

Fig 26: Renamed Slab Groups · Fig 27: Renamed Railing Groups Fig 28: Renamed Stair Group 

6. Create a new group called as 'Foundation' and move the items related to foundation from the wall group to the 
created foundation group (Figure 29). 

7. Rename the items as per the requirement (Figure 30). 

T Fol.J'ldation New Group ~ion ( .. . 

.,. New ltem_2 • Damp Proof Course ( .. . 

.,. New ltem_3 • Foundation Brick (20) 

.,. New Item_ 4 • Foundation Conaete ... 

.,. New ltem_S Plinth (20) 

Fig 29: Foundation Group 

Volume 

Volume 
Volume 

Volume 

., FOUldation New Group Description ( ... 

.,. Damp Proof CoUISe • Damp Proof CoUlSe ( ... 

.,. Foundation Brick W ... . Foundation Brick (20) 

.,. Foundation Concrete • Foundation Concrete ... 

... Plinth Plinth (20) 

Fig 30: Renamed Foundation Items 

Volume 
Volume 

Volume 

Volume 
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8. Rearrange the wall group. 
Takeoff 

~@@ lview AII d G:J 
~ WBS Description 

~ 'f' BIM Project {134) 

~ 11> Wall Basic Wall (30) 

~ ... Doo!s Doo!s (8) 

~ ..,slab AOO!S (2) 

~ ... Foundation Foundation (80) 

'f'Wall Basic Wall (30) ~ ... Ra~ing Railings (4) 

11> Partition Wall 4.5" waU (14) Volume ~ 11> Staircase Stair (1) 
.., Main Wall . 9"WaU (16} Volume ~ 11> Windows & Ventilators Wmdows (9) 

- ~ - -
Fig 31: Wall Group Fig 32: Final Group Structure 

9. Add the cost value for all the items. 

1'1/t>rkbook 

00 1 3o v.ew: {3D} --h, -
VJBS + I ··--·--· I - j .. ~--· . 1 Total I Total Cost j 

~ BIM Project . ___ __ I 28.16.235.29 ! 4.89.951 .83 [ 33.06.187.12 
.- BIM Project.Door.! Door.! 22.500.00 2.250.00 24.750.00 
._- - BIM Pmjecl.foundation I Foundation 11.54.034.91 . 2.43.085.78 . 13.97.121.65 
.- _ ' BIM Project.RaUing_ _ _ _ jR,it.,g;-- _ .. :- _ -:l ___ s:soo.oo I - _ ~ 400.00 6.000~ 

.. 
1 
BIM ProjectSiab r Floors 7.80.833 98 , , 1.17.125.10 , 8.97.959.08 

.- · BIM Projeci.S!a<eaSe Sta< I 1.500.00 300.00 · , 1.800.00 
- - -- =-:;;i - - --

.. BIM Project.WaD Basic WaD 8.34.265.40 1.25.139.96 9.59.405.35 

.- ' BIM Project.Wif!do"-s & Ventilators I W!l'ldows 17.500.00 1.650.00 19.150.00 

Fig 33: Workbook 

10. Follow the below given steps to create the Abstract Estimation. 

60 

a. Reports menu » Custom Reports 

i. In General tab; 

Name= Abstract Estimation 

Report Type = Groups (items only) 

Level of Hierarchy = All 

Select the 'BIM Project' in the Available 

list and load the same into Selected list. 

Reports ' ~ _ X __ 

r--

General I •N- I ._., I '""' nu ..,..., • ...,., , 

Name: 

BIM Project 

Report Type: 

[Group (lems Only} .. J 

Takeoff Entity 

Level of Hierarchy: 

I~ , 1 
Available Selected 

r------------== 

0 ·r§;:.JJ .• 
!71 ... Slab ·Floors : Di 
~ .,. Staircase -Stair 1 

.. W jodnw<: A v~n~G 
0 Ill l l2Jm i 

Create Report J [ Cancel 

Fig 34: General Tab 

Chapter 4 8 
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Building Estimation and Costing 

b. In the Columns tab, select the following. 

1. Description 

ii. Material Cost 

iii. Labor Cost (Figure 35) 

d. In the Layout tab, select 'Show Grid' and 'Landscape: 

e. In the Headers and Footers tab, 

i. Header » Insert the Company Logo 

ii. Footer » Set the page numbers (Figure 36) 

-- ---~ ----~~ · . -~ 

Header: Avail •ble 

0 
Selected 

Equipment Cost WBS 'Insert Graphic ... 
Quantity 1 [3] Description 

Quantity 2 Material cost 
D:\Derno\25yrs logojpg 

Remorks 

G 
Labor Cost 

Subcontractor Cost 

Tnne 

Footer: 

!Page 1 of? 

G Page 1 of ?j 

Create Report II Cancel Create Report J l Cancel 

Fig 35: Columns Tab Fig 36· Header & Footer 

Group(l..,..Only) 

WBS 

Unite- ToiOICost 

lM PtcjKI. Doo~ 

BIM Projta.Doo~.O 4'X7 5.000.00 5,000.00 

BIM ProjRttOoors:.D1 4,500.00 4.500.00 

BIM Projtet0oors.D2 3'X 7 2,500.00 5.000.00 

BIM Project 0oors.D3 2.5' X 7' 2.000.00 8,000.00 

lt,o .... o.- F' ..... ...... ~ -

F1g 37: Abstract Estimation 

11. Export the report to '*.XML' format. 

a. File » Export » Quantities 

b. Select 'All Sheets' and 'Export Hidden Takeoff' options 

Sheets 

10 Current Sheet Only 

@ All Sheets 

Takeoff 

Select this check box to include all items 
current hidden on tile Takeoff Palette. 

111 Export Hidden Takeoff 

Unite-

OK Jl Cancel 

F g Export Quantities 

Labore-

Toeolc-

400.00 400.00 

350.00 350.00 

250.00 500.00 

250.00 1,000.00 

CADD® 
CENTRE 

Tocalc-

Rs2.346.780J7 

24.750.00 

5.400.00 

4.850.00 

5,500.00 

9,000.00 

1 ~01 1~1~ 
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12. Open the created *.XML file in Microsoft Excel and do the required modifications. 

Item ~ Items Quantity 1 ~ Cost unit I Teal I -- ·- UII '-OJ I 
BIM Proiect Rs. 19,81,968.89 
Doors \Doors Rs. 22,500.00 
Ooors\01 \ Doors Door 1.000 ~8 Rs. 4,500.00 Rs. 4,500.00 

4.000 u Rs. 2 000.00 
1.000 ee Rs. 5,000.00 

looors\03 \Doors 2.5' X 7' 
fooors\0 \ Doors 4' X 7' 

Rs. s,ooo.oo 
Rs. 5,ooo.oo 

Ooors\02 \ Doors 3' X 7' 2.000 ea Rs . 2,500.00 Rs. s,ooo.oo 
SIBb \ floors Rs. 7,80,833.98 
Slab\Fioor Slab \floors Floor Slab - 6" 650.695 ftJ Rs. 600.00 Rs. 3,90,416.99 
I slab \Roof Slab \Floors Roof S/eb - 6" 650.695 fp Rs. 600.00 Rs. 3,90,4 16.99 
RBilina \R.ailinas Rs. 5,600.00 
IRailing\Railino \Railings uoomm 2.000 ea R.s. 2 500.00 Rs. 5,000.00 
I Railing\Hand Rail \Railinas Rectanauler - SOxSOmm 2.000 ee Rs. 300.00 Rs. 600.00 
Staira~se \Steir Rs. 1,5oo.oo 
Staircase \Staircase \Stair 19Dmm max riser 250mm going 1.000 ea Rs. 1,500.00 Rs . 1,500.00 

. Windows & Ventiletors !\ Windows Rs. 17,500.00 
Windows & Ventilators\Windows 1\Windows\M_Casement Obi with Rs. 15,500.00 
windows 8c. ventilators\ Windows\Wl \Windows\M ca~mf!nt Obi with 4 'X 4' 4.000 f!l!l Rs.2 000.00 Rs. 8,ooo.oo 
Windows &. Vf!ntil~tors\Windows\W \Windows\M t:aSf!ment Obi with 5' X4' 3.000 e~ Rs. 2 soo.oo Rs. 7,500.00 
Windows & Ventilators\Ventiletors \Windows\M Louvers with Trim Rs. 2,000.00 
Windows & ventilators\Ventiletors\ \Windows \Pol Louvers with Trim 2' X 2' 2.000 ee Rs. 1 000.00 Rs. 2,000.00 
Foundation \Foundation Rs. 11,54,034.91 
Foundation\Damp Proof Course \found~tion Damp Proof Course 34.055 ftJ Rs. 100.00 Rs. 3,405.53 
Fo undetion\Foundation Brick Work \Foundation Foundation Briek 558.249 fp Rs. soo.oo Rs. 2,79,124.52 
Foundetion\foundetion Concrete \Foundation Foundation Cone:rete 767.826 ftJ Rs . 700.00 Rs. 5,37,478.08 
Foundation \Plinth \Foundation Plinth 477.181 ft 1 Rs. 700.00 Rs. 3, 34.026.78 

Fig 39: Abstract Estim at ion in Excel Sheet 

13. Repeat the step number 10 to 12 to create Detailed Estimate. Do the following modifications to achieve the same. 

a. Report Type = Group (Items and Objects) 

b. In-the Column tab, select the following columns 

i. Description 

ii. Material Cost 

iii. Labor Cost 

iv. Count 

v. Area 

vi. Volume 

~ 
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